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Abstract  

In this work, the segregation of particles with different properties is experimentally 

studied. The main attention is focused on mixtures of particles of different shapes, but 

also differently sized particles are considered. The experimental tests have been run with 

spherical particles of different size and with two types of ellipsoids as non-spherical 

particles. The mixer that has been used is a rotating drum with a very low thickness that 

allowed to consider only radial phenomena. The analysis of the mixtures in the drum has 

been carried out by a specific image analysis procedure developed with the open-source 

ImageJ software. It is shown that the shape determines segregation phenomena that occur 

with a dynamic similar to size segregation phenomena. The phenomenon does not depend 

neither on the initial configuration of the system nor on the rotational speed of the drum 

and its filling level.  

The experimental work has been conducted at the Chemical and Process Engineering 

Department of the University of Surrey.  
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Introduction 

Mixing is one of the most common operation carried out in industry. In particular, mixing 

of solids is a widespread unit operation in particulate processes where consistency and 

homogeneity of the product is a key requirement. A proper mixing of granular materials 

is fundamental, for example, in the drugs formulation but also in many other industrial 

fields, such as the food one, in which quality specification must be ensured.  

Generally, particulate materials are made of particles that have different properties (size, 

density, shape) and when they are mixed together segregation phenomena are 

experimented. Segregation, however, has to be avoided since most of the processes 

require homogeneous mixtures: it is of relevant importance to understand segregation 

phenomena and to know how they occur so to be able to control and even try to avoid 

them.  

Many experimental studies exist about segregation; in particular, size-induced and 

density-induced segregation phenomena have been widely investigated. About shape 

segregation, instead, limited experimental studies have been developed and the 

phenomenon has been investigated mainly through numerical simulations. However, it is 

important to extend the experimental study also to different shaped particles, considering 

that in many practical cases particles have an irregular shape and the case of spherical 

shape, often assumed as a reference, is just an ideal one. For this reason, this work was 

mainly focused on the experimental investigation of mixtures made of particles of 

different shape. Ellipsoids were used as non-spherical particles, with the aim of 

understanding if mixtures of spherical and ellipsoidal particles segregate and which 

operative variable can affect the system; also, mixtures of ellipsoids were considered. 

Size segregation was experimented too, due to its relevance. The experimental study has 

been conducted in a rotating drum, which is one of the most common mixer among the 

ones industrially adopted. The considered drum had a very thin thickness, in order to 

realize only a monolayer of particle; therefore, it was possible to focus only on the study 

of radial segregation and no axial phenomena were considered. The analysis of the system 

was done through image analysis, with a procedure developed with the ImageJ software.  



Introduction 2 

This work is divided into three chapters. The first one introduces the main concepts 

related to the topic in question: mixing and segregation mechanisms are presented, 

together with the mixers used industrially. Also, the previous studies developed about 

size and shape segregation in rotating drums are reported. In the second chapter, the used 

particles are described, together with all the equipment; the experimental procedure 

followed in the experimental tests is presented as well. Finally, the results are reported 

and discussed in the third chapter.  

  



 

 

 

 

Chapter 1 

Mixing and segregation 

 

Mixing is a process operation aimed at obtaining a homogeneous system starting from 

two or more components. On the contrary, when there is a lack of homogeneity within 

the mixture segregation occurs. Segregation phenomena represent a relevant problem in 

the case of mixing processes.  

In this chapter, the main concepts related to mixing and segregation will be presented. 

Also, previous studies about size and shape segregation in the rotating drum are reported.  

 

 

 

Three types of mixture can be defined: 

1. Perfect mixture: mixture of two types of particles in which in each position of 

the space the composition is the composition of the whole mixture. This 

represents an ideal situation, not possible in reality.  

2. Perfect random mixture: mixture in which there is the same probability of 

finding a particle of one component in each point of the mixture. This is the 

maximum degree of mixing realizable.  

3. Segregated mixture: mixture in which there is a high probability of finding one 

component in a certain region of the considered space. This configuration occurs 

typically when the components of the mixture present different properties.  

The three types of mixture are reported in Figure 1.1  

1.1 Mixture classification 
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Also, there is another type of mixture, the structured or interactive mixture, obtained 

when cohesive big particles are covered by fine particles with a homogeneous layer. In 

this case, if the interactions are very high segregated mixtures may form.   

1.2 Mixing mechanisms  

Differently from liquids and gases, solid particles are not thermal activated system and so 

in order to obtain a certain degree of mixing they need to be mechanically activated.  

According to Rhodes (1998), three different mixing mechanisms can be distinguished: 

1. Dispersion: it is analogous to diffusion in fluids. It involves single particles 

that randomly move due to collision between each other.  

2. Convection: it involves a portion of the bulk material, with a precise 

direction and velocity.  

3. Shear mixing: it is peculiar to granular solids and it is a combination of the 

two previous mechanisms. It combines a convective motion between layers 

of materials with and individual randomness across the planes.  

In non-cohesive powders, dispersion and shear mixing affect segregation between 

particles; the convective mechanism instead is the main mixing mechanism.  

 

 

 

 

Figure 1.1. Three types of mixture: a) perfect mixture; b) perfect random mixture; 

c) segregated mixture (Rhodes, 2008). 
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1.3 Types of mixers 

Powder mixers are relatively simple machines of low capital cost. They are classified into 

two types: tumbling mixers and agitated mixers.  

1.3.1 Tumbling or diffusive mixers 

Tumbling mixers are the simplest and the most common type. A totally enclosed vessel 

is rotated about an axis causing the particles within the mixer to tumble over each other 

on the mixture surface. In most cases the vessel is attached to a drive shaft and supported 

on one or two bearings; in the case of a horizontal cylinder, rotation can be effected by 

placing the cylinder on driving rollers.  

The most common vessels of this type are: 

• Horizontal drum. 

• Double cone. 

• V-tumbler. 

• Y-tumbler. 

They are shown in Figure 1.2: 

 

Tumbling vessels provide low-shear environments and they are used when materials are 

shear sensitive or non-agglomerating. 

To achieve better dispersion the presence of internal baffles is often required. In some 

cases, a high-speed impeller operating on the same axis of rotation as the shell can be 

used for extending the application of the tumblers to agglomerating and cohesive 

mixtures.   

Figure 1.2 Tumbling mixers: a) horizontal drum; b) double cone mixer; c) V-mixers and Y-mixer 

(Rhodes, 2008). 
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1.3.2 Agitated or convective mixers  

Convective mixers are characterized by the action of impellers or paddles to move the 

powders around and generate a well-mixed product.  

The most common types of convective mixers are: 

• Ribbon mixer. 

• Nauta mixer or orbiting screw mixer. 

• Plow mixer. 

• Paddle mixer. 

• Horizontal double cone with buffles. 

In these mixers, the mixing mechanism is the convective one. Convective mixers provide 

more shear into the mixture and tend to be utilized for cohesive materials.  

1.4 Flow regimes in the rotating drum  

Rotating drums are extensively used in the chemical and process industries; they are 

employed in the chemical, pharmaceutical, food, detergent and metallurgical industries 

to perform mixing, drying, decoating, heating and chemical reactions. With respect to 

mixing processes, rotating drums are used to study and understand mixing phenomena; 

as a result, many studies were developed about granular behaviour in rotating drums.  

Different granular flow regimes can occur in the drum, each one with its specific flow 

behaviour. In particular, different flow regimes can be assessed by using the 

dimensionless Froude number which is defined by the following formula: 

 

𝐹𝑟 =  
𝜔2𝑅

𝑔
                                                       (1.1) 

 

where ω [s-1] is the drum rotation speed, R [m] the drum radius and g [m/s2] the 

gravitational acceleration.  

The different types of bed motion may be subdivided into three basic forms (Mellmann, 

2001): 

• Slipping motion. 

• Cascading (or tumbling) motion. 

• Cataracting motion. 
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Figure 1.3 illustrates the different flow regimes.  

1.4.1 Slipping motion  

Slipping motion can occur under favourable frictional conditions between the solid bed 

and the cylinder wall. There are two types of slipping motion: 

• Sliding; 

• Surging. 

When the drum wall is very smooth, sliding regime may be observed in which the bed is 

constantly sliding from the wall. This can also occur at higher rotational speed and filling 

levels of the drum (Rutgers, 1965).  

With higher wall friction, sliding turns into surging, characterized by periodic alternation 

between adhesive and kinetic friction of the bed on the wall. The solid bed adheres on the 

rotating wall up to a certain angle of deflection and subsequently slides back on the wall 

surface.   

No mixing takes place in slipping motion and so this is usually an undesirable behaviour 

in practice that must be avoided by the use of rough walls or bars attached to the walls.  

1.4.2 Cascading (or tumbling) motion 

Cascading motion is observed when there is a sufficient wall friction. At different 

rotational speeds and with different particles size, three states of motion are possible: 

• Slumping. 

Figure 1.3. Forms of motion in rotating drums (Mellmann, 2001). 
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• Rolling. 

• Cascading. 

When the rotational speed is low, slumping of the bed may occur; the solid bed is 

continuously elevated, levelled off again and again by successive avalanches at the 

surface. 

Increasing the rotational speed, a transition to rolling regime takes place. This motion is 

characterized by a uniform, steady flow of a particle layer on the surface (cascading layer) 

while the larger part of the bed (plug flow region) is moved upwards by solid rotation 

with the rotational speed of the wall. A uniform and good mixing is achievable with this 

type of motion, but when particle size distribution is very broad segregation can appear.  

When the rotational speed of the drum further increases the surface starts to arch and 

cascading sets in.   

Tumbling motion is the prevailing form of motion used in practice and undesired slipping 

motion can be prevented by creating enough wall friction conditions. The rolling bed is 

preferred, since is the simplest regime providing favourable conditions for heat transfer 

and high quality of the product even when mass flow rates are large. However, there are 

also many industrial cases where drums are operated in cascading regime.  

1.4.3 Cataracting motion 

At higher rotational velocities, the cascading motion is so strongly pronounced that 

individual particles detach from the bed and are thrown off into the free space of the drum. 

The release of particles is a characteristic feature of cataracting motion which may be 

subdivided into the following states of motion: 

• Cataracting. 

• Centrifuging. 

When particles are flung into the gas space, cataracting motion occurs.  

With increasing the rotational speed, particles start to adhere to the wall and the extreme 

case of cataracting motion, centrifuging motion takes place. Centrifuging reaches its final 

state when all the solid material is in contact with the drum wall as a uniform film; this 

state is only reached at extremely high rotational speeds.  
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1.5 Segregation phenomena  

When particles to be mixed have different properties such as different size, different 

density or different shape segregation can occur and so, especially considering long 

mixing times, the particles tend to separate. (Fitzpatrick, 2009). Difference in size is by 

far the most important cause of particle segregation. 

Four mechanisms of segregation according to size can be identified (Williams, 1990): 

 

1. Trajectory mechanism: according to the Stokes’ law, the limiting distance (L) 

that a particle can travel is: 

 

L =  
𝑢 𝜌𝑝𝑑𝑝

2

18 𝜇
                                                (1.2) 

 

where u is the particle velocity, ρp the particle density, dp the characteristic 

dimension of the particle and μ the viscosity of the fluid in which the particles 

move. So, the velocity of fine particles is lower than the velocity of big particles. 

This can cause segregation when particles move through air and it also happens 

when powders fall from the end of a conveyor belt. 

 

 

2. Percolation mechanism: if a mass of particles is disturbed in such a way that 

individual particles move, a rearrangement in the packing of particles occurs. If 

the powder is composed of particles of different size, it will be easier for fine 

particles to fall down and percolate in the void space between bigger particles 

Figure 1.4. Segregation due to particles trajectories (Rhodes, 2008).  



Chapter 1 10 

 

that instead can raise up. Segregation by percolation can occur whenever the 

mixture is disturbed, causing rearrangements of particles. 

 

3. Inertial mechanism: it occurs typically in pouring and filling operations. The 

bigger particles tend to flow to the bottom of the pile of powders since they have 

a higher momentum; smaller particles instead have lower momentum so tend to 

accumulate in the centre. 

 

4. Elutriation mechanism: when very small and big particles are present, in 

presence of air the fine ones can remain in suspension after the larger ones have 

settled to the surface of the system. This occurs in charging storage vessels or 

hoppers.  

 

Figure 1.5. Segregation by percolation (Rhodes, 2008). 

Figure 1.7. Segregation by elutriation (Rhodes, 2008). 

Figure 1.6. Inertial mechanism of segregation. 
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(b) 

1.6 Literature review 

The existing literature related to size segregation and shape segregation in rotating drums 

is reviewed in this paragraph.  

1.6.1 Size segregation 

A homogeneous binary granular mixture in a two-dimensional rotating drum typically 

demonstrates radial segregation. This occurs typically due to differences in size and 

density. Size-induced radial segregation had been investigated by several authors.  

Cantelaube and Bideau (1995) specifically studied radial segregation in a two-

dimensional rotating drum where segregation by percolation was supposed to be absent. 

The drum was made of two glass disks, with a diameter of 60 cm, held together by an 

iron annulus. About 1400 disks, whose diameter varied from 6 to 22 mm, were used to 

fill half of the drum. The drum was moved by a motor at a rotation speed equal to 1.3 rpm 

that could be changed in order to maintain the continuous-flow regime. The system was 

filmed and the pictures were analysed by an image processing program. Small white and 

larger black disks were used. It was observed that the kinetics of segregation was very 

fast: the small white disks were localized in the centre of the packing in less than one 

revolution, as shown in Figure 1.8.  

 

By adding tracer particles into the granular bulk, also Clément et al. (1995) showed size 

segregation. They used a cylinder partially filled with steel beads that have a diameter 

equal to 1.5 mm. The cylindrical drum had a diameter of 200 mm and rotated at constant 

(a) 

Figure 1.8. (a) Homogeneous mixture at t=0; (b) the same mixture after one revolution 

(Cantelaube and Bideau, 1995). 
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low speed (2 degrees/s) to keep the avalanche regime; the experimental set-up is reported 

in Figure 1.9. A tracer of the same material was placed in the system. The beads and the 

cylinder were treated to darken their surface while the test particle was steel bright. Tracer 

particles with different sizes were used (1 mm, 1.5 mm and 2 mm). By image processing 

the trajectories of tracer particles were followed. It was displayed that smaller particles 

are attracted to the centre of the drum; larger particles tend to move to the edge of the 

system and tracer particle of the same size of the beads mix homogeneously. 

 

 

Also, some mathematical models were developed, trying to predict segregation in the 

rotating drum.  

Prigozhin and Kalman (1998) studied mixing and size segregation of a binary mixture in 

a partially filled rotating drum and proposed a mathematical model of material transport, 

considering free-surface segregation. Their cylindrical vessel had a 141 mm internal 

diameter and a 36 mm length. The binary mixture that filled the drum was made by 

spherical particles of two different sizes (d1=1.37 mm and d2=2.51 mm); all particles were 

made of zirconium oxide with a density of 4.14 g/cm3. Axial segregation was not 

considered and percolation was neglected; also, it was assumed that mixing and 

segregation occurred in a thin surface layer. Considering that the initial composition of 

the bulk was given, the mass transport equations were evaluated. These equations allowed 

to determine the material composition and the concentration in the filling surface layer. 

Also, the operator of segregation was defined and so the local composition of a general 

layer was determined. To find the constitutive equation governing the free surface 

segregation of binary mixtures the procedure developed by Prigozhin (Prigozhin, 1993) 

Figure 1.9. Bidimensional rotating drum (Clement et al., 1995). 
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was followed. A good agreement of theoretical and experimental data was found. The 

model obtained was able to predict the material distribution for various drum fillings and 

compositions, even if, due to its simplifications, the applicability is limited to slow 

rotational speed. 

Van Puyelde et al. (2000) developed an empirical model, by conducting some 

experiments in order to study the effect of particle size ratios on both segregation 

dynamics and the final segregated configuration. Coloured shale was used in the 

experiments. Mean particle sizes were 0.89 mm, 1.70 mm, 2.51 mm, 3.44 mm and 5.08 

mm; the density was not significantly different for all the particles and so segregation due 

to density differences would not occur. The particle size ratio varied from 5.7, for the 0.89 

mm and 5.08 mm particles, to 1.37, for 2.51 mm and 3.44 material. The steel drum had a 

570 mm inner diameter and a 50 mm thick cross section; two removable semi-circular 10 

mm thick plate glass sections were attached to the frame. The rear section was connected 

to a shaft powered by a variable DC power supply. A camera allowed to take pictures of 

the beds and to derive the model by the use of image analysis. The fine material was 

coloured orange and the larger particles were coloured black. The initial configuration of 

the system was a well-mixed bed; rotation was started and images were taken from the 

initial state until the final segregated configuration. Images were taken every second for 

60 seconds, with the drum in motion. In order to analyse the system, the bed was divided 

in two concentric layers: the inner layer had a radius of 50% of the bed radius from the 

centre and the remaining area of the bed represented the outer layer. For low rotational 

speed the segregation time was measured, but it was not possible at higher velocities, 

since the segregation occurred too fast to be observed. A concentration proportion was 

used to express the distribution of the segregating material and the final segregated 

concentration proportion was defined as the average concentration proportion in each 

layer when the bed was fully segregated. It was found that the fine material tended to 

move toward the centre of the bed for all experiments but this tendency was reduced with 

smaller particles ratios and higher active layer velocities. The concentration proportion 

could be determined with the following correlation: 

 

𝑃𝑗 = 𝑚(𝑃𝑆𝑅)𝑉̅𝐴𝐿 + 𝑖(𝑃𝑆𝑅)                                             (1.3) 
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(a) (b) 

Where 𝑉̅𝐴𝐿 was the mean active layer velocity m(PSR) and i(PSR) were the gradient and 

intercepts functions for the different particle size ratios respectively. It was found a small 

range of particle size ratio, close to 1, where segregation had not occurred and so the 

values of m(PSR) and i(PSR) were equal to the boundary condition values. A final upper 

limit value was observed for the larger particle size ratios, probably due to the onset of 

spontaneous segregation. The region between the lower and upper limits was linear, as 

shown in Figure 1.10.  

Also, the amount of fine materials in each layer could be calculated by multiplying the 

concentration of each layer by the volume of the layer.  

 

 

 

The half-filled rotating drum was investigated also by Thomas (2000). He studied the 

radial segregation in the system, considering glass beads with diameters between 45 μm 

and 7.5 mm and with density equal to 2.5 g/cm3. First, a drum with a length of 42 mm 

long and a diameter of 48.5 mm was considered; it was filled with small and large beads 

and rotated manually by rolling it on a plane. The rotation speed was between 0.04 and 

0.09 s-1. Experiments were conducted varying the diameters ratio. Some experiments 

were conducted with 16.6% large black beads (d=710 μm or d=3 mm) and small beads 

of different sizes. It was observed that large beads roll on the surface for small size ratios 

and rapidly sink for high size ratios; for very large size ratios, they move along the slope 

before reaching the surface and flow embedded in a layer of small beads. Using large 

particles with d=710 μm and small particles with diameters d=500 μm or d=45-90 μm, 

axial and radial segregation occurred. For size ratios lower than 2.3, the large beads were 

at the surface and at the periphery of the drum; for size ratios from 2.8 to 4.3, the large 

Figure 1.10. a) Rolling bed showing segregated core; b) modelling of m(PSR) and i(PSR) for 

the inner layer (Van Puyelde et al., 2000).  
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(a) (b) 

beads were close to the periphery; for size ratios higher than 7.8, large beads were 

uniformly distributed inside. Some examples are reported in Figure 1.11, for different 

values of the particles size ratio.  

 

 

The same occurred with 3 mm large beads, demonstrating that the process does not 

depend on the diameter of the beads but on the size ratio. Other experiments were made 

with 3% of 3 mm large beads. Large beads tended to accumulate on a circle on a 

preferential distance from the centre and the circle moves from the walls when increasing 

the diameter ratio. Moreover, a variation by a factor of about 10 in the rotational speed 

was considered, finding that the results were very similar. Thus, speed seemed not to 

affect the results in the range of speed considered for the experiments. In addition, 

Thomas studied a clear plastic disk placed horizontally and rotating with a speed equal to 

0.04 s-1 around its axis. The disk had a 3.5 mm thickness and a diameter equal to 81 mm; 

the large beads in the drum were 710 μm, 1.5 mm and 3 mm in diameter. The segregation 

patterns were the same as in the previous drum and the phenomenon occurred for the 

same diameter ratios. Again, it was observed that large beads seemed to have a constant 

vertical location compared to the free surface and their vertical relative position depend 

on the size ratio: starting from the free surface, the beads are then increasingly embedded 

when enlarging the diameter ratio. Considering 3-mm large beads, it was observed that 

they can act as plugs and strongly affect the flow in the system. In fact, when a 3-mm 

bead sinks in the bed and stops at a certain distance, it prevents the flow of the following 

small beads.  

Figure 1.11. Cross section of the drum for (a) size ratio equal to 1.42 and (b) for size 

ratios larger than 7.8 (Thomas, 2000). 
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1.6.2 Shape segregation 

The case of spherical particles is often assumed as a reference and many of the existing 

studies consider spherical particles only. However, also different geometries have to be 

considered since the particles shape has a strong influence on the dynamics of the system. 

There exist limited experimental investigations of non-spherical particles flow in rotating 

drums and also there is little knowledge about the granular dynamics of non-spherical 

particles inside the rotating drums. 

Some experiments were conducted in a rotary kiln considering nickel oxide pellets, 

limestone, sand and gravel (Henein et al., 1983, 1985): the effect of particle shape on bed 

motion was determined. Also, particles made from and with ovoid, shell and tube shapes 

were used to investigate the effects of particle type on mixing in the rotary kiln. (Woodle 

and Murno, 1993); it was shown that particle type has an effect on mixing time. 

Considering the importance of partially filled rotating cylinders in practical applications, 

Boateng and Barr (1997) experimentally studied the behaviour of granular materials in 

rotary cylinders. To cover a large range of particle shapes, they considered spherical 

uniformly sized polyethylene pellets, ellipsoidal non-uniformly sized rice grains and 

unequally shaped and sized limestone particles. The rotary drum had a 1 m outer diameter 

and a 1 m length and it was rotated by an electrical motor with variable speed. Figure 

1.12 reports their experimental set-up. 

 

Rotation rates between 1 and 5 rpm were used and the drum loading was varied from 

3.3% to 29%. The rotational Froude number was between 5.4 × 10-4 and 1.3 × 10-2. 

Particle size, particles density, static angle of repose, interparticle and particle-to-wall 

(a) (b) 

Figure 1.12. Schematic of experimental set-up: (a) transverse flow; (b) geometry of flow field. 

(Boateng and Barr, 1997). 
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coefficients of restitution were measured for the three different types of particles. The 

fibre-optic technique allowed to measure particle velocities within the bed and at the free 

surface. Two fotonic sensor-probe were used: they were made by a light source connected 

to the probe tip by a transmitter and a light sensor which communicate with the probe tip. 

Two probes in parallel and 5 mm apart measured particles velocities: when the tip was 

aligned with the flow, the passage of a single particle produced an identical signal in each 

probe with a delay equal to the time required for the particle to travel the distance between 

the probes. Polyethylene was analysed with many different drum loadings (3.3%, 8.5%, 

15% and 29%) and at the full range of rotational speeds; rice grains were loaded at 3.3%, 

8.5% and 10% fills at 3 and 5 rpm only; limestone was run at a speed between 2 and 5 

rpm with a loading not exceeding 8.5%. It was found that the spherical polyethylene 

pellets exhibit a lower angle of repose (25°) than rice grains (32°) and limestone (35°). 

Furthermore, some differences were found in the velocity profiles. At low drum loading 

all three materials show linear velocity profiles but at higher loadings non-spherical 

materials developed more parabolic profiles and the deviation from linearity seemed to 

increase with the rotation rate. This was explained considering the thermodynamics of 

the system and the collisions between particles. Between polyethylene particles elastic 

collision occur and a singular surface velocity profiles develop; inelastic collisions occur 

between rice grains and limestone particles giving rise to the build-up of material at the 

apex. 

Ingram et al. (2005) used PEPT technique to characterize axial and radial dispersion of 

granular media in a rolling drum operated in batch and continuous mode. They used three 

drums with a length of 1000 mm and with internal diameters of 120, 240 and 390 mm; 

the drums were mounted on rollers driven by a variable speed motor. Sand and titanium 

dioxide were analysed, with a filling level between 10% and 30% and rotation speed up 

to about 6 rpm. Sand particles had a mass mean diameter of 475 μm and a bulk density 

of 1640 kg/m3; titanium dioxide mass mean diameter was 1275 μm and its bulk density 

equal to 1575 kg/m3. The experiments displayed that drum speed, drum diameter and 

drum fill level does not affect the radial and axial dispersion coefficients. Particle shape 

seemed rather to affect the system but this factor was not considered in the study.  

Santomaso et al. (2006) experimentally studied mixing processes in a horizontal rotating 

cylinder, considering materials with the same size and different angle of repose. The 
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horizontal cylinder that was used was 0.11 m long and had a radius of 0.046 m; the system 

was filled up to 30% in volume with two different materials completed axially segregated. 

Blue and white tetraacetlyenethlydiammine (tead) powders were mixed to allow 

composition quantification by image analysis; also, sodium percarbonate (sp) powders 

with a spheroidal and irregular shapes were used. A solidification technique of the 

mixture was used: after a fixed number of revolutions at low speed the mixture was 

saturated with molten wax, then solidified and cut into nine slices. Information about the 

radial composition distribution were obtained by image analysis of the slices, dividing 

the system into 12 rings and calculating the relative grey intensity on each ring. Radial 

segregation was observed and, for the blue and white tead, it was found to be a transient 

phenomenon that faded out at longer mixing times. When powders with not only different 

angle of repose but also different density were considered, much stronger radial 

segregation was observed; moreover, in some cases the phenomenon was found to be 

permanent. The kinetics and intensity of the segregation increased with increasing the 

initial difference of dynamic angle of repose. 

The dependence of the dynamic angle of repose on particles shape was also investigated 

(Santomaso et al., 2007) in a rotating drum partially filled with powders. The considered 

drum had an internal diameter of 0.192 m and a length of 0.1 m; it was placed on two 

steel rollers and rotated at different rotational speed between 1 and 8 rpm. The dynamic 

angle of repose of eight different materials was measured by taking pictures of the 

material by back lighting technique. The angle was found to be constant for all the 

materials except one. Also, a correlation for the angle was derived, relating the dynamic 

angle of repose to the Roundness and the Elongation, two parameters that quantify the 

particles shape. 

The dynamics of non-spherical particles in rotating drums has been considered only 

recently (Dubè et al., 2013). Dubè et al. used pharmaceutical tablets as non-spherical 

particles. Their rotating drum operated in the rolling regime and so two regions 

characterized the system: a passive layer near the walls and an active layer in which 

mixing and segregation mainly occur. The drum had a 0.3556 m internal length and a 

0.2413 m internal diameter; it is schematically displayed in Figure 1.13. 
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(b) (a) 

 

 

Five different tablets were considered with a specific size and composition; for all the 

experiments 35 vol% as filling fraction was used. The tablets are schematically 

represented in Figure 1.14.  

 

 

 

 

 

 

 

 

 

 

 

 

The tablets had a density equal to 1.40, 1.58, 1.63, 1.54 and 1.29 g/cm3, respectively. 

They were tested individually, but also bi-dispersed mixtures of mono-shaped tablets and 

bi-disperse mixtures of bi-shaped tablets were studied. In the blends 85 vol% of the bigger 

tablet and 15 vol% of the smaller tablets were used. The drum rotational speed was 10 

rpm; only one experiment was performed at 5 rpm in order to assess how the drum speed 

affects the particle dynamics. Furthermore, to compare non-spherical particles dynamics 

to the spherical one, three experiments were done with spherical glass beads. Radioactive 

Figure 1.13. (a) Cross-section view of the drum; (b) a close-up on the active layer (Dubè et 

al., 2013). 

Figure 1.14. Schematic representation of the non-spherical tablets (Dubé et al., 2013). 
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particle tracking (RPT) technique was used to follow the particle motion. A tracer was 

used which can emit isotropic γ-rays that are then used to show its trajectory. The static 

and dynamic repose angles were evaluated, finding significant differences between 

spherical particles and non-spherical ones. Tablets with a longer straight side can form 

stable structures near the wall and so they present a higher dynamic repose angles and 

even if they have a different aspect ratio, they show similar dynamic repose angles. 

Moreover, when tablets with similar dynamic repose angles are mixed the resulting angle 

is the same as the individual one. In all the experiments, a bed dilation was measured: this 

phenomenon is a characteristic of non-spherical granular flow and in fact was not 

displayed by spherical particles. It was found that all the individual tablets and blends 

show a higher velocity profile than the glass beads. Previously developed models used 

for spherical particles adequately describe the velocity profile of non-spherical particles, 

except when the non-spherical particles have an aspect ratio higher than two.  

Alan and Scheper (2016) conducted experiment using rice particles and spherocylindrical 

steel particles, finding that spherocylinders do not have the same segregation mechanism 

as spherical particles. First, some experiments were conducted with rice particles. A 

wooden drum was used, with a radius of 125 mm and a depth of 25 mm which rotated at 

4 rpm. The drum was 45% filled with a premixed mixture of two particles of different 

size. All rice particles were coloured with a food dye to have a high contrast for the optical 

analysis. A camera was used to take pictures of the mixtures and, in particular, every 

rotation a picture was taken to compare the mixing state; the PEPT technique was used 

to obtain the location of the particles. Another experiment was done with a wooden drum 

with a 260 mm diameter rotating at 4 rpm and 45% filled with steel rollers. The particles 

had a diameter which varies from 1.5 to 4 mm and a length between 7.8 and 19.8 mm; 

their density varied from 323.1 to 7800 kg/m3. Pictures of the mixtures were taken after 

0, 2 5 and 10 rotations. The steel rollers started in a segregated state and reached an 

equilibrium mixed state after only 5 rotations; the rollers also showed a tendency to form 

cluster of the same constituents. In the experiments, no segregation was observed on a 

large scale; a possible explanation to this non-segregation behaviour is the fact that 

particles form clusters and so they segregate just on a smaller scale.  
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1.6.3 Summary of previous studies 

Size segregation was widely observed experimentally. Considering a rotating drum 

operating in the rolling regime filled with particles of different sizes, bigger particles 

mainly tend to the edge of the system, while smaller particles are attracted to the centre 

of the drum. The phenomenon occurs very fast and the rotational speed of the drum seems 

not to affect the phenomenon; the size ratio of the particles is, instead, the parameter that 

mainly affects size segregation phenomena.  

Most of the experimental investigations about segregation in the rotating drum involved 

spherical or nearly-spherical particles; the experimental studies of the flow of non-

spherical particles are, in fact, rather limited. The shape of the particles, however, strongly 

influences the motion in the system. In particular, the static and dynamic angles of repose 

of non-spherical particles are found to be very different from the ones measured for 

spherical particles. Moreover, for mixtures of non-spherical particles a dilation of the 

granular bed is observed, finding it to be a characteristic phenomenon of non-spherical 

particles, not displayed by spherical ones.  

 

  



 

 

 

 



 

 

 

 

Chapter 2 

Materials and methods 

In this chapter, the particles used for the experiments will be presented, with all their 

characteristics. The measurement of particle density, the used equipment and the 

experimental set-up will also be described. Moreover, a specific image analysis procedure 

was developed to analyze the pictures of different mixtures in the drum. The method, that 

was elaborated with the ImageJ software, will be explained in this chapter. It was 

developed starting from the analysis of the single particles and it was then applied to 

analyze binary mixtures of particles of different shape and size in the rotating drum. Some 

information about the ImageJ software can be found in the Appendix, together with 

details about the used commands; they could be useful to better understand the procedure 

that was used.  

2.1 Materials  

In this paragraph, the spherical and non-spherical particles used for the experiments are 

described and shown. The non-spherical particles used in this work are 3D printed 

particles so some information about the 3D printing are reported, too.  

2.1.1 Spherical particles  

Spherical particles of different dimensions were used for the experiments. They are shown 

in Figure 2.1  
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The biggest spherical particles were nylon-66 beads with a diameter of 8 mm, while the 

intermediate sized were plastic particles with a diameter of 6 mm. Their geometrical 

characteristics are reported in the following table: 

 
Table 2.1. Diameter, projected area and volume of the spherical particles. 

d [mm] A [mm2] V [cm3] 

8 50.265 0.268 

6 28.274 0.113 

 

Where A is the projected area of a sphere, calculated as: 

 

𝐴 =
𝜋

4
𝑑2                                                        (2.1) 

 

And V is the volume of a sphere: 

 

𝑉 =
𝜋

6
𝑑3                                                        (2.2) 

 

The smallest particles were not exactly spherical and they were not all exactly of the same 

size. They were used since they were available in the laboratory in high quantity. The 

shape and the mean diameter of these particles were evaluated by scanning a sample of 

42 particles on a paper sheet. A picture of the particles (Figure 2.2 (a)) was obtained and 

the particles could be analysed in ImageJ in order to define their mean size and shape. 

 

 

Figure 2.1. Three types of spherical particles used in the experimental tests. 
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a) b) 

 

The results of the analysis are summarized in Table 2.2. The shape of the particles was 

evaluated in terms of Aspect Ratio.  

 

Table 2.2. Mean diameter and mean aspect ratio of the smallest particles. 

d [mm] AR [-] 

3.810 1.176 

 

The mean aspect ratio of the particles was not very different from 1 so these particles 

could be assumed very similar to spherical ones. The projected area and the volume of 

the smallest particles are reported in Table 2.3.  

 

Table 2.3. Projected area and volume of the particles with 3.81 mm diameter. 

A [mm2] V [cm3] 

11.401 0.0290 

 

The density of all the spherical particles was measured experimentally; this will be 

reported in paragraph 2.1.3.  

2.1.2 Ellipsoids 

Two types of ellipsoids were considered, which are shown in Figure 2.3 (a). 

For the sake of simplicity, in the following the particles with the shorter length will be 

indicated with the number 1 while the more elongated particles with 2. 

Figure 2.2. a) Scanned picture of the smallest particles; b) outlines of the particles as 

a result of the analysis. 
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b1 

b2 

a1 

a2 

a) 

Each ellipsoid presents three characteristic geometrical dimensions, which correspond to 

the three semi-axes of the ellipsoid. In this case, the ellipsoids were designed in such a 

way to have two semi-axes equal to each other. So, there were two geometric dimensions 

relevant for each ellipsoid: they were two axes of the ellipsoids, which are indicated as a 

and b, as reported in the sketch of the particles shown in Figure 2.3. The third axis, c, was 

equal to b.  

 

 

 

 

 

 

 

 

 

 

 

 

The two types of ellipsoids had different shape and their shape was quantified by the 

Aspect Ratio, which was defined as the ratio between the larger and the smaller relevant 

dimension of the particle and so in this case it was the following ratio: 

 

𝐴𝑅 =  
𝑎

𝑏
                                                         (2.3) 

 

The aspect ratio is equal to one in the case of spherical particles.  

The geometric characteristics of the particles are reported in Table 2.4 in detail: 

 

Table 2.4. Geometrical characteristics of the two types of ellipsoids. 

Type a [mm] b [mm] AR [-] A [mm2] V [cm3] 

1 10.48 6.98 1.5 57.452 0.267 

2 18.44 5.26 3.5 76.179 0.267 

 

The projected area (A) of the ellipsoids [mm2] was calculated with the following formula: 

Figure 2.3. a) Types of ellipsoids; b) sketch of ellipsoid 1; c) sketch of ellipsoid 2.  

  

b) 

c) 
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𝐴 =  𝜋 ∙
𝑎

2
∙

𝑏

2
                                                       (2.4) 

 

The volume (V) of the particles [cm3] was calculated as: 

 

𝑉 =  
4

3
 𝜋 ∙

𝑎

2
∙

𝑏

2
∙

𝑐

2
∙ 10−3                                        (2.5) 

  

Where c=b in this case.  

As it is displayed in Table 2.4, the two types of ellipsoids were design in order to have 

the same volume; the volume was also equal to the volume of the spheres with diameter 

equal to 8 mm, described in the previous paragraph.  

Since the particles were not spherical, an equivalent diameter could be defined in order 

to compare their size with the spherical particles. The particles are three-dimensional 

particles so the equivalent diameter by volume was used. As the ellipsoids have the same 

volume of the spheres with 8 mm diameter, their equivalent diameter by volume will be 

equal to 8 mm. This could be checked by equalling the expression of the volume for the 

sphere and for the ellipsoids and extracting the value of the equivalent diameter by 

volume (deq,v).  

 

4

3
 𝜋 ∙

𝑎

2
∙

𝑏

2
∙

𝑐

2
=

𝜋

6
𝑑𝑒𝑞,𝑣

3                                            (2.6) 

 

And so, the equivalent diameter by volume for the ellipsoids was: 

 

𝑑𝑒𝑞,𝑣 = √8 ∙
𝑎

2
∙

𝑏

2
∙

𝑐

2

3
                                              (2.7) 

 

The value of the equivalent diameter resulted to be equal to 7.99 mm for both the 

ellipsoids.  

Furthermore, the ellipsoids were 3D printed, but not all of them were printed with the 

same 3D printer. The first particles available (100 for each type) were printed by the 3D 

printer of the mechanical workshop of the University of Surrey. They are made of a 

special plastic material suitable for 3D printers which is the VisiJet® M3 Crystal. It is a 

translucent material with high durability and stability and with a density of 1.02 g/cm3. 
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When more particles had been needed, they were printed with the Ultimaker 3D printer 

available in the Chemical and Process Engineering Department of the University of 

Surrey. The material used in this case was the polylactic acid (PLA). 

The density of all the particles was experimentally measured and the measurement will 

be described in the next paragraph.  

2.1.3 Density measurement  

The density of all the particles used for the experiments was measured with a gas 

pycnometer. The features of the instrument and the procedure followed for the density 

measurement will be reported in this paragraph.  

2.1.3.1 The gas pycnometer  

The Multivolume Pycnometer 1305 was used, which is reported in Figure 2.4. 

 

 

An electrical connection was required for the operation of the instrument, together with 

the gas supply; nitrogen was used in this case. 

The gas pycnometer allowed to measure the skeletal volume of the solid sample by 

observing the reduction of gas capacity in the sample chamber caused by the presence of 

the sample.  

Figure 2.4. Multivolume Pycnometer 1305. 
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The pycnometer is provided with a sample chamber, in which the sample is placed, and 

an expansion volume. The sample chamber is made of stainless steel and it has two holes 

for the gas inlet and outlet. The volume of the chamber is of about 154 cm3.  

2.1.3.2 Density measurement procedure  

For each type of particle two measurements of density were done. After the sample was 

loaded, the sample chamber was charge to a pressure of about 19.5 psig by feeding the 

gas; this pression was recorded as P1. Subsequent expansion in the expansion volume, 

which was previously at the same temperature and at zero psig, resulted in a second 

pressure, recorded as P2. Application of mass balance equations for the gas permitted easy 

computation of the sample volume (Vsample) since the volume of the empty sample 

chamber (Vcell) and of the expansion chamber (Vexp) were known and the pressure drop 

ratio upon expansion was known. In particular, the volume of the sample was calculated 

as: 

 

𝑉𝑠𝑎𝑚𝑝𝑙𝑒 =
𝑉𝑐𝑒𝑙𝑙−𝑉𝑒𝑥𝑝

(
𝑃1

𝑃2
⁄ )−1

                                                    (2.8) 

 

The values of Vcell and Vexp are reported in the following Table: 

 

Table 2.5. Volume of the empty sample cell and of the expansion volume of the pycnometer. 

Vcell [cm3] Vexp [cm3] 

8.595 5.763 

 

The mass of the sample (msample) was evaluated by determining the weight of the cup 

containing the sample and subtracting the weight of the cup.  

Finally, the density of the sample (ρsample) was calculated as: 

 

𝜌𝑠𝑎𝑚𝑝𝑙𝑒 =
𝑚𝑠𝑎𝑚𝑝𝑙𝑒

𝑉𝑠𝑎𝑚𝑝𝑙𝑒
                                               (2.9) 

 

The procedure was repeated to obtain a second value of density. The final value of density 

was obtained as a mean of the two measurements.  



Chapter 2 30 

 

Table 2.6 reports the recorded values of P1 and P2 for each measurement, the mass, the 

volume and the density of each sample. Also, for each measurement the standard 

deviation (STD) is indicated. 

 

Table 2.6. Gas pycnometer measurement data for each type of particle. 

Sample P1 [psig] P2 [psig] m [g] V [cm3] 
ρ 

[g/cm3] 

mean ρ 
[g/cm3] 

STD 

[g/cm3] 

spheres d=8mm 19.527 10.698 1.808 1.612 1.122 
1.093 0.029 

spheres d=8mm 19.480 10.611 1.808 1.700 1.064 

spheres d=6mm 19.570 10.522 2.211 1.893 1.168 
1.194 0.026 

spheres d=6mm 19.483 10.534 2.211 1.811 1.221 

particles d=3.81 19.568 10.509 1.997 1.909 1.046 
1.060 0.014 

particles d=3.81 19.516 10.517 1.997 1.860 1.074 

ellipsoids AR=3.5 19.725 10.918 1.814 1.450 1.251 
1.256 0.005 

ellipsoids AR=3.5 19.644 10.885 1.807 1.433 1.261 

PLA ellipsoids AR=3.5 19.441 10.798 1.373 1.395 0.984 
0.983 0.001 

PLA ellipsoids AR=3.5 19.480 10.808 1.387 1.412 0.982 

ellipsoids AR=1.5 19.561 10.397 2.470 2.056 1.201 
1.194 0.008 

ellipsoids AR=1.5 19.415 10.300 2.470 2.083 1.186 

PLA ellispoids AR=1.5 19.407 10.383 1.853 1.964 0.944 
0.955 0.012 

PLA ellispoids AR=1.5 19.710 10.580 1.853 1.917 0.967 

 

All the particles have similar densities and so segregation phenomena due to different 

density are avoided.  

The measured density of the spheres with 8 mm diameter is very close to the typical 

density of the nylon 66 (1.14 g/cm3). The spheres with 6 mm diameter and the particles 

with mean diameter equal to 3.8 mm have a density very similar to the big spheres, of the 

order of magnitude of the density of polymeric materials. 

The same type of ellipsoids printed with two different 3D printed have a slightly different 

density. Also, the PLA ellipsoids have a density that is lower than the typical density of 

the PLA (1.24 g/cm3). This is because the particles were printed with a set infill density 

of the 20%, so they are partially empty inside.  
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The density of the particles (ρparticle), by definition, can be also measured as the following 

ratio: 

 

𝜌𝑝𝑎𝑟𝑡𝑖𝑐𝑙𝑒 =
𝑚𝑝𝑎𝑟𝑡𝑖𝑐𝑙𝑒

𝑉𝑝𝑎𝑟𝑡𝑖𝑐𝑙𝑒
                                              (2.10) 

 

Where mparticle is the mass of one particle [g]; Vparticle the volume [cm3] of each particle 

that was reported in the previous tables (see Tables 2.1, 2.3 and 2.4). 

The mass of one particle of each type was calculated by weighting a known number of 

particles and dividing the obtained mass for the number of weighted particles; higher the 

number of weighted particles was and lower the measurement error. The values of mass, 

volume and density are reported in the following table: 

 

Table 2.7. Values of mass, volume and density of each type of particle. 

Particles  m [g] V [cm3] ρ [g/cm3] 

spheres d=8mm 0.301 0.268 1.123 

spheres d=6mm 0.131 0.113 1.162 

particles d=3.81 0.0215 0.029 0.741 

ellipsoids AR=3.5 0.313 0.267 1.170 

PLA ellipsoids AR=3.5 0.230 0.267 0.861 

ellipsoids AR=1.5 0.312 0.267 1.167 

PLA ellispoids AR=1.5 0.232 0.267 0.868 

 

By this measurement, it can be checked that the density of all the particles is very similar 

and very close to 1 g/cm3. The density of the PLA ellipsoids is found again to be slightly 

lower than 1 g/cm3, due to the setting defined in the 3D printer.  

2.1.4 3D printing  

A 3D printer allows to obtain three-dimensional objects through additive manufacturing, 

starting from a digital file. The object is created on a support plane thanks to a nozzle 

moving on the plane. In particular, the additive process creates the object by laying down 

successive layers of material until the object is created. Each of the layers can be seen as 

a thinly sliced horizontal cross-section of the eventual object.  
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The starting point is a 3D design of the object to be created. This can be realized with 

specific software. The 3D design has to be saved in the STL format and it is then uploaded 

on a slicing software. The slicing is the operation of dividing the 3D design into sections 

and each one represents a different perspective of the moulded piece. In the slicing 

software, all the printing parameters and the needed data are set. Finally, when the 3D 

model is sliced it can be fed to the printer. The printing occurs layer by layer since the 

printer reads every 2D slice and creates the three-dimensional object.  

The software used to realize the 3D design of the particles used in this work is FreeCAD, 

which is an open-source parametric 3D modeller allowing to obtain STL files. By 

exporting the file, it is possible to save it in the STL format and so it is ready to be printed.  

One of the 3D printer used to print the non-spherical particle is shown in Figure 2.5.  

 

 

As said before, in the printer showed above the filling degree of the object to be printed 

(infill density) was set equal to 20% in order to have a fast printing.  

 

 

 

 

 

 

Figure 2.5. Ultimaker 3D printer used to print some of the non-spherical particles. 
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a) b) 

 

 

In this paragraph, the experimental set-up is described and displayed in detail. 

2.2.1 The rotating drum  

The experiments presented in this work were conducted by using the rotating drum shown 

in Figure 2.6.  

 

The drum is made of two transparent polycarbonate disks with a diameter of 30 cm and a 

thickness of 6 mm; between them a wooden spacer is placed, with the same external 

diameter, an internal diameter of 25 cm and a thickness of about 9.1 mm. The spacer 

allows to create an internal space of defined thickness which separates the two 

polycarbonate disks. The internal thickness is covered with a sandpaper layer in order to 

have enough friction and avoid undesired slippage of the particles. Moreover, to keep the 

drum in vertical position and allow its rotation, three more wooden spacers are used, at a 

distance of about 16.3 cm.  

This rigid structure can rotate at variable rotational speed thanks to a motor connected to 

a voltage supplier.  Two rollers mounted on a rigid support make the rotation of the drum 

possible; a pulley transmits the motion to the driving roller, while the second roller is 

passive and it just keeps the drum in position during the rotation. The rotational speed can 

be changed by varying the voltage of the motor, with a maximum allowed voltage of 12 

2.2 Experimental equipment 

Figure 2.6. a) Front view and b) side view of the rotating drum. 
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V. The structure can be removed from the rollers and by unscrewing the bolts the drum 

can be easily opened so that the particles can be loaded in the drum. 

2.2.2 The recording system   

Pictures of the drum were taken by a colour camera and then analysed by the image 

processing program ImageJ.  

To avoid the reflection of the camera and other objects on the front transparent disk, a 

squared LED panel was used which allowed to have a dominant diffused light 

illuminating the drum. The LED had a power of 8 W and a colour temperature of 4000 

K; it was placed behind the drum and opposite to the camera. A circular sheet of paper, 

which was attached to the drum between it and the LED, diffused the light properly.  

The camera was a Basler ace camera – model acA2000-165uc, with a maximum 

resolution of 2040 × 1086 pixels. The focalization and the diaphragm of the camera could 

be adjusted manually. For each picture, the two parameters were adjusted in order to 

ensure that the objects to be analysed were properly focalized and that the picture were 

not too bright. The camera was fixed on a support placed about 28 cm far from the rotating 

system and connected to a laptop on which the pylon Viewer 64-bit software was installed 

for the acquisition of the pictures. In the software, some features could be set; they could 

be saved and reloaded, so that it was not needed to set them each time. The value of the 

most relevant parameters of the camera are summarized in the following table: 

 

Table 2.8. Main features set in the pylon Viewer software. 

Balance White Auto Once  

Exposure time [μs] 3000 

Acquisition Frame rate [Hz] 200 

Width [pixel] 1080 

Height [pixel] 1080 

OffsetX  576 

OffsetY 0 

 

In particular, Width, Height, OffsetX and OffsetY of the picture were set up in the Image 

Format Control section of the software.   

The Width and the Height were always set equal to 1080, in order to obtain 1080 × 1080 

squared pictures with a high resolution.  
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The offset values were defined in order to have the drum exactly at the centre of the lens.  

Also, the white balance was required before taking pictures or videos of the system and 

it could be done in the Image Quality Control.  

Finally, the Exposure Time modulated the light entering in the lens of the camera: it was 

usually set equal to 3000 μs.  

Before starting a recording, the frequency of the frames (fps) was set in the Options menu. 

A time-based recording was set. It has to be specified that with the set resolution, reported 

in Table 2.8, 600 frames can be recorded at maximum, due to the maximum size of the 

video.  

The whole experimental set-up is displayed in Figure 2.7. 

2.2.3  Velocity calculation 

The rotational velocity of the drum was changed by changing the voltage of the motor.  

On the front of the drum a marker was placed and the following procedure was used to 

evaluate the rotational speed: 

1. The rotation of the drum was started at a given voltage.  

2. The recording of the rotating drum was started with fps=0.2 s. 

3. A given position of the marker was assumed as reference and the frame at which 

the marker was at the reference position was recorded as f1. 

Figure 2.7. Experimental set-up made of the rotating drum, the colour camera and 

the laptop for the acquisition of the pictures.  
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Figure 2.8. a) Reference frame f1; b) frame f2 after one rotation of the drum. 
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Figure 2.9. Rotational speed of the drum vs. the voltage of the motor. 

a) b) 

4. After one rotation, the frame at which the marker was again at the reference 

position was recorded as f2. 

5. The rotational velocity [rpm] was evaluated as: 

 

𝜔 = (
1

(𝑓2−𝑓1)∙𝑓𝑝𝑠
) ∙ 60                                            (2.11) 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

The rotational speed was evaluated for different voltages; the trend of the rotational 

velocity as a function of the voltage of the motor is reported in Figure 2.9.  

 

 

 

 

 

 

 

 

 

 

 

 

 

The plot shows that the speed of the drum changed with the voltage in a linear way.  
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2.3 Experimental plan  

The experiments reported in this work concern segregation and mixing phenomena of 

particles of different shape and size. The main attention was focused on mixtures of 

particles with different shapes, since segregation phenomena due to different size had 

been widely investigated and many studies exist related to it.  

2.3.1 Mixtures of particles of different shapes 

The particles that were considered to investigate segregation phenomena due to different 

shape are the ones described in the previous chapter (see § 2.1.1 and § 2.1.2). Three 

mixtures were considered, with two different initial segregated configurations.  

The experimental tests are summarized in the following table. 

 

Table 2.9. Experimental tests performed with differently shaped particles. 

AR 1 [-] AR 2 [-] ω [rpm] φ [-] initial configuration time [min] repetitions 

1 1.5 4.22 25% E/S 30 3 

1 1.5 4.22 25% S/E 30 1 

1 1.5 4.22 47% E/S 30 3 

1 1.5 4.22 47% S/E 30 1 

1 1.5 11.51 25% E/S 30 3 

1 1.5 11.51 47% E/S 30 3 

1 1.5 4.22 25% E/S 2 1 

1 3.5 4.22 25% E/S 30 3 

1 3.5 4.22 25% S/E 30 1 

1 3.5 4.22 47% E/S 30 3 

1 3.5 4.22 47% S/E 30 1 

1 3.5 11.51 25% E/S 30 3 

1 3.5 11.51 47% E/S 30 3 

1 3.5 4.22 25% E/S 2 1 

1.5 3.5 4.22 25% E2/E1 30 3 

1.5 3.5 4.22 25% E1/E2 30 1 

1.5 3.5 4.22 47% E2/E1 30 3 

1.5 3.5 4.22 47% E1/E2 30 1 

1.5 3.5 4.22 25% E2/E1 2 1 

 

AR 1 and AR 2 indicate the aspect ratios of the particles in the binary mixture. It is 

reminded that the spheres (AR=1) and the two types of ellipsoids (AR=1.5 and AR=3.5) 

have the same volume.  
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The E/S initial configuration indicates a segregated configuration with ellipsoids above 

spheres below (this was assumed as basis configuration); the S/E configuration is the 

inverted initial configuration with spheres above and ellipsoids below. For the mixtures 

of ellipsoids, E2 indicates the ellipsoids with AR=3.5, while E1 the ellipsoids with 

AR=1.5.  

All the experiments were performed with binary mixtures with a composition of 50% and 

50% on a number basis, so with an equal number of particles of the two types. 

The filling level (φ) of the 25% was obtained with a total number of particles equal to 200 

(100 particles of one type and 100 of the other type); with 320 total particles (160 of each 

types) the filling level of the drum was equal to 47%.  

Since recording the system for 30 minutes does not allow to set a low fps, some tests were 

performed for two minutes: in this case it was possible to set a fps=0.2 s and so to better 

observe the system and the phenomena occurring.  

2.3.2 Mixtures of particles of different sizes  

Some experiments with particles with the same shape but with different size were 

performed. The particles were described in paragraph 2.1.2.  

 

Table 2.10. Experimental tests performed with differently sized particles. 

Size 1 [mm] Size 2 [mm] ω [rpm] φ [-] initial configuration time [min] repetitions 

3.81 8 4.22 24.734% S1/S2 2 1 

6 8 4.22 24.915% S1/S2 2 1 

 

The number of particles was defined in order to have binary mixtures with a composition 

of 50% on a volume base and a filling level as equal as possible to 25%. The volume 

occupied by the particles of a certain dimension was calculated as the product between 

the volume of one particles and the number of particles. The initial configuration was a 

segregated one, with the bigger spheres placed below and the smaller ones above (S1/S2). 

One test was performed for each mixture. Since size segregation phenomena are known 

to occur fast, the drum was rotated for just two minutes.  
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2.4 Particles analysis  

Firstly, the particles described in paragraph 2.1.2 were considered for the image analysis. 

They were not immediately placed in the drum, but simply on a black cardboard and some 

pictures were taken. The pictures were then analysed with ImageJ in order to obtain the 

position and the orientation of each particle. An example of the analysed pictures is 

reported in Figure 2.10. 

 

 

To analyse the particles the following operations were done: 

1. First the picture was converted into an 8-bit image, as the Threshold operation 

works only with grayscale images. 

2. Then a proper threshold was set to separate the particles from the background. 

3.  Finally, the results for each particle were obtained with the Analyze Particle 

command. Also, the Outlines of the particles could be obtained. 

The procedure followed to obtain the results is reported in the following code:  

 

// ELLIPSOIDS 

selectWindow("Image1.jpg"); 

run("8-bit"); 

setAutoThreshold("Default dark"); 

//run("Threshold..."); 

//setThreshold(157, 255); 

setOption("BlackBackground", false); 

a) b) 

Figure 2.10. a) Ellipsoids of type 1; b) ellipsoids of type2. 
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run("Convert to Mask"); 

run("Close"); 

run("Analyze Particles...", "size=100-Infinity 

show=Outlines display"); 

String.copyResults(); 

 

  In Figure 2.11 the outlines obtained for the two pictures reported above are shown.  

  

 

 

 

 

 

 

 

 

 

 

Table 2.11 contains an example of the more significant results obtained for five particles 

of the type 1. 

 

Table 2.11. More significant results for the ellipsoids of type 1. 

 Area [pixel2] XM [pixel] YM [pixel] Circ. [-] Feret [pixel] 
FeretAngle 

[degrees] 
AR [-] Round. [-] 

1 12111 402.927 199.043 0.849 147.411 36.170 1.390 0.719 

2 11624 980.721 238.318 0.826 153.395 94.112 1.575 0.635 

3 11842 302.74 456.526 0.835 149.272 176.543 1.474 0.678 

4 11303 492.605 491.349 0.833 150.233 101.908 1.543 0.648 

5 11354 845.627 546.189 0.816 149.402 64.636 1.512 0.661 

 

In Table 2.12 the results for the particles of type 2 are shown. 

 

 

 

 

Figure 2.11. a) Outlines of the ellipsoids of type 1; b) outlines of the ellipsoids of type 2. 

a) b) 
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Table 2.12. More significant results for the ellipsoids of type 2. 

  
Area [pixel2] XM [pixel] YM [pixel] Circ. [-] Feret [pixel] 

FeretAngle 

[degrees] 
AR [-] Round. [-] 

1 13563 983.564 320.828 0.505 247.348 68.414 3.527 0.284 

2 13781 386.346 257.208 0.544 243.463 3.532 3.381 0.296 

3 13499 758.998 295.605 0.526 243.417 28.46 3.442 0.291 

4 13791 280.208 400.826 0.552 243.249 34.278 3.345 0.299 

5 13657 1217.299 533.695 0.489 242.012 115.189 3.364 0.297 

 

The area of each particle was obtained together with the coordinates of the centre of mass, 

indicated as XM and YM. The Feret’s diameter (Feret) was also evaluated and the angle 

of the Feret’s diameter was displayed as Feret Angle. The Aspect Ratio (AR) defined the 

shape of the particles; the roundness (Round.) is the inverse of the Aspect Ratio. Finally, 

the circularity (Circ.) is defined as 4π·Area/(Perimeter)2 and it is a dimensionless 

parameter equal to 1 for a perfect circle; as it approaches 0 it indicates a more elongated 

shape: so, the circularity could give information about the particles shape as well. It has 

to be noted that the values of area, centre of mass and Feret’s diameter are expressed in 

pixels, since no units were defined to calibrate the picture. 

A similar procedure was repeated in the case of a mixture of the two types of particles. In 

the case of touching particles, the Erode command and the Watershed operation were 

required to separate them. An example is reported in the following pictures; also, the code 

is reported.  

 

 

Figure 2.12. a) Mixture of two types of ellipsoids; b) outlines obtained as a result.  

a) b) 
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// MIXTURE 

selectWindow("Image2.jpg"); 

run("8-bit"); 

setAutoThreshold("Default dark"); 

//run("Threshold..."); 

//setThreshold(119, 255); 

run("Convert to Mask"); 

run("Erode"); 

run("Watershed"); 

run("Analyze Particles...", "size=100-Infinity 

show=Outlines display"); 

String.copyResults(); 

 

Successively, to have a contrast between the two type of particles it was decided to paint 

one type of them with a different colour. This allowed to repeat the threshold twice, once 

for the light particles and once for the darker particles and so better identify them when 

touching each other. So, the particles of type 2 were darken with a black paint. Some 

pictures of the black particle were taken placing them simply on a light desk. The outlines 

of the particles are shown in Figure 2.13.  

 

Figure 2.13. a) Ellipsoids of type 2, darken with a black paint; b) outlines of the dark particles.  

b) a) 
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Some problems for the image analysis appeared considering a mixture of light and dark 

particles. The particles were placed on a green surface in order to have a high contrast 

between the background and the objects.  

For the light particles, it was possible to set a proper threshold and analyse them, obtaining 

the results for each particle. 

 

For the black particles, instead, it was not possible to set a proper threshold, and the results 

could not be obtained, as it can be seen in the following images. 

 

The difficulties mainly originated from the light of the environment and from the shadows 

and reflection on the black particles. To solve the problem, the use of an intense and 

diffusive light was needed to enlighten the particles and remove any reflection. To get the 

proper lighting a LED panel was used, able to ensure an intense light that was diffused 

Figure 2.14. a) Original picture; b) threshold of the light particles; c) outlines of the light particles.  

Figure 2.15. a) Original picture; b) threshold of the dark particles. 

a) b) c) 

a) b) 
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by the use of a paper sheet. The optimization of the light was realized directly on the 

drum, where the particles were put.  

2.5 Drum analysis  

The particles were afterwards placed in the drum. The drum was not already mounted on 

the rollers that allowed to rotate it, but it was simply kept in vertical position. Moreover, 

also spheres with diameter of 8 mm (described at § 2.1.1) were added together with the 

ellipsoids. The drum was illuminated by the LED, placed very close to the drum and 

pictures were taken by the colour camera. In particular, mixtures of spheres and ellipsoids 

were considered and, the ImageJ program was used to identify the different types of 

particles in the drum. 

2.5.1 Binary mixtures of spheres and ellipsoids with AR=1.5  

Spheres and ellipsoids with Aspect Ratio equal to 1.5 were considered in the drum and 

analysed, taking into account mixtures with different composition. Some pictures are 

reported in Figure 2.16. 

 

 

The procedure followed in ImageJ was equal to the one described in the previous 

paragraph. The two types of particles had both a light colour, so the Threshold operation 

was done once only. The ImageJ results were obtained for both the spheres and the 

ellipsoids. The Outlines are displayed in Figure 2.17. 

Figure 2.16. Binary mixtures made of spheres and ellipsoids with AR=1.5. 
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It was possible to distinguish the spheres from the ellipsoids due to their different shape: 

the Aspect Ratio was the parameter used for this aim. The values of the aspect ratio for 

some particles of the two types are reported in Table 2.13. They are obtained from the 

analysis of a mixture of spheres and ellipsoids of type 1, as the ones reported in Figure 

2.16. 

 

Table 2.13. Values of Aspect Ratio obtained from image analysis. 

AR [-] 

Spheres Ellipsoids 

1.027 1.314 

1.063 1.384 

1.017 1.471 

1.057 1.561 

1.010 1.543 

 

The value of the aspect ratio was very close to 1 for the spheres; for the ellipsoid, instead, 

the value was higher, close to 1.5. 

The identification of the two types of particles through the aspect ratio was more difficult 

for the particles at the border of the drum; in some case, in fact, the ellipsoids were 

erroneously identified as spheres. Also, the presence of the border of the drum 

complicated the Watershed operation.  

 

 

 

Figure 2.17. Outlines for the binary mixtures of spheres and ellipsoids with AR=1.5 of Figure 2.16. 
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2.5.2 Mixtures with ellipsoids with AR=3.5  

Also, mixtures with elongated particles with aspect ratio equal to 3.5 were considered. 

An example is reported in Figure 2.18. 

 

In the case of those mixtures, the correct identification of the black particles following 

the procedure used so far was not suitable. Problems arose from the possibility for these 

particles to overlap each other, being not individually identifiable. Moreover, the 

Watershed operation very often led to an oversegmentation, as it is shown in the following 

picture: 

 

 

 

 

 

 

 

 

 

As it can be seen in Figure 3.10, in some cases two or more particles were identified 

together. However, the most problematic issue was the oversegmentation of the particles: 

Figure 2.18. Ternary mixture of spheres, ellipsoids with AR=1.5 and ellipsoids with AR=3.5.  

Figure 2.19. Outlines of the black particles of Figure 2.18 obtained with the Watershed operation. 



Chapter 2 47 

 

some particles instead of being identify as one were cut in two or more pieces by the 

Watershed. The reason of the oversegmentation was found in the algorithm that is at the 

basis of the Watershed operation (see Appendix A).  

To solve the problem and better identify the black particles, different attempts were made.  

Firstly, the black particles were bleached in order to have them in their original light 

colour. However, the change in colour did not solve the oversegmentation problem. 

Therefore, other ImageJ plugins were taken into account, looking for a plugin able to 

properly identify overlapping and touching object. The Graylevel Watershed, the 

Morphological Segmentation and the Distance Transform Watershed plugins were tried 

but without significant improvements. The best solution was found in an ImageJ plugin 

called Adjustable Watershed in which the tolerance can be set: higher the tolerance and 

lower the segmentation of the analysed objects. With this plugin was not possible to 

separate all the ellipsoids and identify them individually, but it was possible to effectively 

reduce the oversegmentation. The Outlines obtained for the black particles of Figure 2.18, 

with the Adjustable Watershed are reported in Figure 2.20. 

 

 

As it can be seen from Figure 2.20, there is a clear difference between the Outlines 

obtained in this case and the ones obtained with the Watershed. Even if also with the 

Adjustable Watershed some particles are erroneously cut, the segmentation is 

significantly reduced and the result is better than the one reported in Figure 2.19.  

Figure 2.20. Outlines of the black particles of Figure 2.18 obtained with the Adjustable 

Watershed with tolerance=4.   
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2.6 Image analysis procedure  

Starting from the preliminary procedure developed and based on the considerations 

reported previously (§ 2.5), a method of analysis was formulated and applied to the binary 

mixtures mentioned in paragraph 2.3. The image analysis procedure allowed to calculate 

the radial distance of the particles in the drum. 

2.6.1  Procedure  

The image analysis procedure is reported in the following. 

1. The starting point of the analysis was a given colour picture of the drum of the 

dimensions of 1080 × 1080 pixels (an example is represented by Figure 2.21(a)).  

2. The sharpness of the picture was increased with the Sharpen option and the 

brightness adjusted at the best value by adjusting Brightness/Contrast. 

3. To obtain a grayscale image the Split Channels command was run. Among the 

three black and white images obtained, the green component of the original 

picture was selected, as it was the best one in terms of sharpness and definition.  

4. To isolate the part of the image of interest, the circular front part of the drum was 

delineated with the makeOval command and then cut and paste in a new blank 

picture of the same dimension of the circle. An example is reported in Figure 

2.21. 

 

 

a) b) 

Figure 2.21. a) Example of original colour image; b) example of the circle cut from the original 

picture obtained after converting the picture to a grayscale one.  
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5. As the circular drum image was inscribed in a squared picture, the centre of the 

drum was assumed to be the centre of the squared picture; the coordinates of the 

centre of the drum were indicated as xc and yc. 

6. Since different types of particles in the drum were always of two different 

colours, the Threshold operation was run twice, once for the light particles and 

once for the black particles. An example of the Threshold operation applied to 

the dark and light particles is shown in Figure 2.22 

 

 

7. The successive operations have to be distinguished between binary mixtures of 

spheres and ellipsoids with AR=1.5 and mixtures with ellipsoids with AR=3.5, 

since the procedure was slightly different in the two cases.  

7.1 In the case of mixtures of spheres and ellipsoids with AR=1.5, the Watershed 

operation was run for both types of particles on the two thresholded images 

and the results for the spheres and the ellipsoids were obtained. In particular, 

from the coordinates of the centre of mass of each particle (xm,i and ym,i) it was 

possible to calculate the radial distance (di) from the centre of the drum of each 

particle. It was calculated as: 

 

𝑑𝑖 = √(𝑥𝑐 − 𝑥𝑚,𝑖)2 + (𝑦𝑐 − 𝑦𝑚,𝑖)2                                (2.12) 

 

Figure 2.22. Threshold operation applied to a) light particles and b) dark particles; the 

original picture is Figure 2.21(a). 

a) b) 
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The mean value of distance (dm) for the spheres and for the ellipsoids was then 

calculated according to the following formula: 

 

𝑑𝑚 =  
∑ 𝑑𝑖

𝑁
𝑖=1  

𝑁
                                                        (2.13) 

 

Where N is the total number of each type of particle. 

7.2 In the case of mixtures of spheres and ellipsoids with AR=3.5 the procedure 

was different. For the spheres, the same was done as described at the previous 

point and the mean distance of the spheres was obtained according to formula 

(2.13). For the ellipsoids, instead, the Adjustable Watershed was used and in 

some cases more particles were identified as one single particle; of each block 

of particles identified by the Adjustable Watershed the coordinates xm,i and ym,i 

and the Area (Ai) were defined. Considering that the ellipsoids with AR=3.5 

were not exactly and individually identifiable, only one value of the two 

coordinates of their centre of mass (xm and ym) was calculated, by weighting 

the values on the area of each identified particle, or block of particles: 

 

               𝑥𝑚 =  
∑ 𝑥𝑚,𝑖𝐴𝑖

𝑁
𝑖=1

∑ 𝐴𝑖
𝑁
𝑖=1

          (2.14),          𝑦𝑚 =  
∑ 𝑦𝑚,𝑖𝐴𝑖

𝑁
𝑖=1

∑ 𝐴𝑖
𝑁
𝑖=1

         (2.15)  

 

From these values, a value of distance from the centre of drum representative of 

all the ellipsoids was calculated from formula (2.12).  

8. Given the values of the mean distance of the two types of particles in the mixture, 

the mean radial distance of all the particles from the centre of the drum (dc) was 

calculated as: 

 

𝑑𝑐 =
𝑑𝑚,𝑠𝑝ℎ𝑒𝑟𝑒𝑠+𝑑𝑚,𝑒𝑙𝑙𝑖𝑝𝑠𝑜𝑖𝑑𝑠 

2
                               (2.16) 

 

9. Also, the coordinates of the barycentre of the granular bed were calculated. 

9.1 In the case of mixtures of spheres and ellipsoids with AR=1.5, the 

coordinates of the barycentre of the spheres (xb,spheres, yb,spheres) were 

calculated as the mean of the xm,i and ym,i of all the spheres. Equally, for 
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the ellispoids, xb,ellipsoids and yb,ellispodis were evaluated as the mean of all 

xm,i and ym,i of all the ellipsoids. The coordinates of the barycentre of the 

granular bed then were: 

 

𝑥𝑏 =  
𝑥𝑏,𝑠𝑝ℎ𝑒𝑟𝑒𝑠+𝑥𝑏,𝑒𝑙𝑙𝑖𝑝𝑠𝑜𝑖𝑑𝑠

2
                                        (2.17)    

 

 𝑦𝑏 =  
𝑦𝑏,𝑠𝑝ℎ𝑒𝑟𝑒𝑠+𝑦𝑏,𝑒𝑙𝑙𝑖𝑝𝑠𝑜𝑖𝑑𝑠

2
                                        (2.18) 

 

9.2  In the case of mixtures of spheres and ellipsoids with AR=3.5, the 

barycentre of the spheres was calculated as the mean of the xm,i and ym,i of 

all the spheres. For the ellipsoids, instead, the values of xm and ym 

calculated by formulas (2.12) and (2.13) were also assumed to be the 

values of the coordinates of the barycentre of the ellipsoids. And so, the 

coordinates of the barycentre of the granular bed were: 

 

𝑥𝑏 =  
𝑥𝑏,𝑠𝑝ℎ𝑒𝑟𝑒𝑠+𝑥𝑚,𝑒𝑙𝑙𝑖𝑝𝑠𝑜𝑖𝑑𝑠

2
                                         (2.19) 

 

𝑦𝑏 =  
𝑦𝑏,𝑠𝑝ℎ𝑒𝑟𝑒𝑠+𝑦𝑚,𝑒𝑙𝑙𝑖𝑝𝑠𝑜𝑖𝑑𝑠

2
                                 (2.20) 

 

10. The values of distance calculated above from the ImageJ results were expressed 

in pixels. They needed to be converted in millimetres and referred to the drum 

dimensions. To define the conversion factor (k), it was considered that the side 

(l) of the square in which the circular front section of the drum was inscribed had 

to be equal to the diameter (D) of the drum. So, the conversion factor was defined 

as: 

 

𝑘 =
𝐷 [𝑚𝑚]

𝑙 [𝑝𝑖𝑥𝑒𝑙𝑠]
                                                        (2.21) 

 

The procedure described above was applied also to the mixtures made of particles of 

different sizes, mentioned at § 2.3.2. It has to be specified that the particles with 3.81 mm 

mean diameter were not detectable with the developed procedure, since they were so 
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small to form more layers in the drum. For the mixture of differently shaped particles the 

distance of all the particles from the centre of the drum (dc) was calculated as the distance 

of the barycentre of the granular bed from the centre of the drum. 

2.6.2 Filling level evaluation  

The filling level (φ) of the drum was evaluated from pictures of the front circular drum 

with the mixture in its initial segregated configuration. Given the circular front picture of 

the drum, to evaluate the filling level, the following procedure was used. 

1. By a proper threshold, the total area of the drum (Atot) was evaluated. 

2. By a proper threshold, the area of all the particles (Aparticles) was calculated, 

including all the voids between particles. 

3. By subtracting the area of all the particles from the total area of the drum, the void 

area of the drum (Avoid) was obtained. 

4. Finally, the filling level (%) was: 

 

𝜑 =  
𝐴𝑡𝑜𝑡− 𝐴𝑣𝑜𝑖𝑑

𝐴𝑡𝑜𝑡
∙ 100                                       (2.22) 

 

2.6.3  Angle evaluation  

Three angles were evaluated for the binary mixtures considered in the drum: 

1. The Maximum Angle of Stability (αmax), which is the maximum angle reached by 

the granular bed before an avalanche occurs.  

2. The Angle of Repose (β) that is the angle formed by the granular bed, after the 

avalanche ends and before the granular bed starts to raise up again.  

3. The Dynamic Angle of Repose (βd), which is the angle of the granular surface 

during the motion. 

From literature, (Cheng, 2016) it was found that the Dynamic Angle of Repose can be 

expressed as the mean of the other two angles:  

 

𝛽𝑑 =
(𝛼𝑚𝑎𝑥+𝛽)

2
                                                (2.23) 
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The angles give information about the particles behaviour in the drum: a higher value of 

the angles indicates the tendency to form more stable structures.  

The pictures from which the angles were evaluated were taken from videos of the rotating 

drum that were recorded with low frequency of the frames (fps= 0.2 s) and high exposure 

time (equal to 35000 μs); the high exposure time allowed to highlight the particles in 

motion in the active layer. 

The three angles could be evaluated following two different methods: 

 

• Method 1 

The angles could be evaluated manually through the Angle Tool available in 

ImageJ. 

In particular, given a picture of the drum, two consecutive lines were drawn: the 

first one was exactly horizontal, the second one fitted the particles surface. The 

Angle Tool automatically estimated the angle between the two lines.  

An example is reported in Figure 2.23 for the evaluation of two angles.  

 

Method 1 gave a correct estimation of the angle. The fitting line, however, was 

drawn manually so the method could be not exactly precise. Moreover, in some 

case the straight line did not fit the surface of the particles at the best, especially 

when the surface is not exactly flat.  

 

Figure 2.23. Evaluation of a) the Maximum Angle of Stability and b) the Angle of Repose 

with the Angle Tool of ImageJ (Method 1). 

a) b) 
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• Method 2 

A more precise estimation could be obtained by calculating the angle that the 

centre of mass of the particles forms with respect to a vertical line passing through 

the centre of the drum.  

For the calculation, first a proper Threshold was set in order to identify all the 

particles as a single object. Then, by the Analyze Particles command, the 

coordinates of the centre of mass of all the particles (xm and ym) were obtained. 

The angle α [degrees] was then evaluated as: 

 

𝛼 = arctan (
𝑥𝑚−𝑥𝑐

𝑦𝑚−𝑦𝑐
) ·

180

𝜋
                                     (2.24) 

 

Where xc and yc are the coordinates of the centre of the drum.  

An example is reported in Figure 2.24. 

 

 

Assuming that the fitting line drawn with Method 1 is perpendicular to the 

segment connecting the centre of the drum and the centre of the particles, it can 

be demonstrated that the two angles calculated with Method 1 and Method 2 are 

the same angle. So, Method 2 could be used to check how correct is the estimation  

made with Method 1.  

Figure 2.24. Evaluation of the angle formed by the particles surface 

with Method 2. 



 

 

 

 

Chapter 3  

Results and discussion 

In this chapter, the results of the experimental tests presented previously (§ 2.3) will be 

exposed and discussed. The results are divided into three main paragraphs. In the first one 

the results for mixtures of particles with different shapes are presented. The second 

paragraph reports the results obtained for mixtures of particles with different sizes. 

Finally, the calculation of the Maximum Angle of Stability, the Angle of Repose and the 

Dynamic Angle of Repose will be presented, in the third paragraph of the chapter. 

All the results were obtained following the procedure described in Chapter 2 (§ 2.6).  

3.1 Mixtures of particles of different shapes  

In this paragraph, the results related to different shaped particles will be reported. 

Different mixtures have been considered, but also different filling levels and rotational 

speeds of the drum.  

3.1.1 Spheres and ellipsoids AR=1.5, ω=4.22 rpm, φ=25% 

Four tests of 30 minutes were performed with the binary mixture made of spheres and 

ellipsoids with AR=1.5, at the conditions reported in Table 3.1. 

 

Table 3.1. Conditions of the tests with spheres and ellipsoids with AR=1.5 at lower filling level. 

AR 1 [-] AR 2 [-] ω [rpm] φ [-] initial configuration time [min] repetitions 

1 1.5 4.22 25% E/S 30 3 

1 1.5 4.22 25% S/E 30 1 

1 1.5 4.22 25% S/E 2 1 

 

Some pictures of the system with the E/S initial configuration are reported in Figure 3.1. 
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The radial distance (dm) of the two types of particles was calculated according to formula 

(2.13), at different time instants and plotted versus time. The trend is reported in Figure 

3.2.  

Figure 3.2. Trend of the radial distance vs. time for the mixture of spheres and 

ellipsoids with AR=1; the graph was obtained by averaging the values of distance of 

the three tests (ω=4.22 rpm; φ= 25%; the initial configuration was the E/S one). 

Figure 3.1. Drum at a) t=0; b) t=5 min; c) t=15 min; d) t=30 min (test 3), (ω=4.22 

rpm; φ= 25%; the initial configuration was the E/S one). 
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d) c) 
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As it can be seen from Figure 3.2, the radial distance varies from the initial value and for 

both the spheres and the ellipsoids settles to a steady value. A steady state is reached and 

kept in time and no other phenomena occur during the time in which the system is 

observed. The mean radial distance of the two type of particles settles to very similar 

values; this can suggest that the two types of particles mix in the drum. However, a deeper 

analysis can be carried out considering the distribution of the radial distance of the spheres 

and ellipsoids. The radial distance from the centre of the drum (d) was divided in classes 

of 10 mm and the number of particles (N) in each class was defined. To obtain the 

distribution, N was normalized on the radial distance and N/d was plotted versus d. In the 

case of completely mixed particles N/d should be constant and equal for the two types of 

particles in each class. 

 

The peak of the distribution of the ellipsoids is found at lower distance than the peak of 

the distribution of the spheres. Moreover, at lower distance, the number of ellipsoids is 

higher than the number of spheres, especially for distances between 70 and 90 mm; at 

higher distance and so closer to the drum wall, instead, the number of spheres is higher 

than the number of ellipsoids. So, the distribution shows that the two types of particles 

are mainly found in two different regions of the system: the ellipsoids at the centre at the 

spheres at the borders of the granular bed.  

Figure 3.3. Distribution of the radial distance of the two types of particles, obtained 

as the average of the distributions of the three tests. The histogram refers to the values 

of radial distance obtained at t=30 min (ω=4.22 rpm; φ= 25%; the initial 

configuration was the E/S one). 
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Also, the number composition (%) of the spheres in each class was obtained by dividing 

the number of spheres by the total number of particles in that class and multiplying by 

100. The trend of the composition versus d is shown in Figure 3.4. 

 

The composition of the spheres decreases at intermediate distances and then increases at 

higher distance from the centre of the drum. It means that the spheres are found in high 

number at the borders while the ellipsoids settle at a preferential distance at the centre of 

the granular bed; the two types of particles do not mix homogenously and so segregation 

occurs. 

To verify whether the initial configuration of the particles could affect the system, one 

test was performed with the same mixture but with the inverted initial configuration, as 

shown in Figure 3.5. 
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Figure 3.4. Trend of the number composition of the spheres vs. the radial distance, 

obtained as the average of the composition curves of the three tests (ω=4.22 rpm; 

φ= 25%; the initial configuration was the E/S one). 
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The trend of the radial distance was found to be the same of the other configuration, as 

reported in Figure 3.6.  

Figure 3.6. Trend of the radial distance vs time for the two initial configurations 

(ω=4.22 rpm; φ= 25%). 

a) b) 

c) 

d) 

Figure 3.5. Drum at a) t=0; b) t=5 min; c) t=15 min; d) t=30 min, (ω=4.22 rpm; 

φ= 25%; the initial configuration was the S/E one). 
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Even if it is more oscillating, the trend of the radial distance of the two types of particles 

is the same of the previous case and it stabilizes to steady values that are equal to the ones 

obtained with E/S initial configuration. The radial distance of the two types of particles 

settles to the same steady value, independently from the initial configuration of the 

system, that so does not affect the final configuration reached in the drum. 

The distribution of the particles at the final time is reported in Figure 3.7.  

 

The distribution is very similar to the one obtained for the tests with different initial 

configuration (Figure 3.3). At lower distance, the number of ellipsoids is higher than the 

number of spheres, while the spheres are present in higher number at larger distances.  

The initial configuration of the particles represents, in fact, the way in which the particles 

are loaded in the drum; so, it is found that loading one type of particles before the other 

one does not affect the final configuration reached by a mixture of spheres and ellipsoids 

with an aspect ratio equal to 1.5 and with the same volume.   

Furthermore, as it can be seen from Figures 3.2 and 3.6, the achievement of the final 

steady state occurs quite fast: after one minute, in fact, the value of distance is the final 

one, or very close to it. To better understand how fast the transition to the final steady 

Figure 3.7. Distribution of the radial distance of the two types of particles. The 

histogram refers to the values of radial distance obtained at t=30 min (ω=4.22 rpm; 

φ= 25%; the initial configuration of the particles was the S/E one). 
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value is, the drum was rotated for a shorter time (2 minutes); it was so possible to record 

the system with higher fps and better observe the phenomenon.  

The radial distance plotted versus time is reported in Figure 3.8.  

 

After 30 seconds, the radial distance reaches the steady state value, so the transition to 

the final state is very fast.  

3.1.2 Spheres and ellipsoids AR=3.5, ω=4.22 rpm, φ=25% 

The tests with the binary mixture of spheres and ellipsoids with AR=3.5 were run at the 

conditions specified in Table 3.2. 

 

Table 3.2. Conditions of the tests with spheres and ellipsoids with AR=3.5 at lower filling level. 

AR 1 [-] AR 2 [-] ω [rpm] φ [-] initial configuration time [min] repetitions 

1 3.5 4.22 25% E/S 30 3 

1 3.5 4.22 25% S/E 30 1 

1 3.5 4.22 25% S/E 2 1 

 

As in the previous case, three tests were run with the E/S initial configuration, as shown 

in Figure 3.9. 

Figure 3.8. Trend of the radial distance vs. time for the 2 minutes test performed 

with the mixture of spheres and ellipsoids with AR=1.5 (ω=4.22 rpm; φ= 25%).  
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In this case, the ellipsoids were found to evidently accumulate at the centre of the granular 

bed, as displayed in the pictures of Figure 3.9. The accumulation of the non-spherical 

particles is shown also by plotting the coordinates of the centre of mass of the spherical 

particles. The elongated particles were not exactly identifiable and so the coordinates of 

the centre of mass were not defined for each particle and could not be plotted; however, 

it was possible for the spherical particles, as reported in Figure 3.10.  

a) b) 

c) d) 

Figure 3.9. Drum at a) t=0; b) t=5 min; c) t=20 min; d) t=30 min (test 1), (ω=4.22 

rpm; φ= 25%; the initial configuration was the E/S one). 
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The blank space between the plotted centres of mass of the spheres is the space occupied 

by the ellipsoids and by the voids between the particles. The more elongated particles 

clearly accumulate at the centre of the granular bed.  

The radial distance of the particles was plotted in time and it is shown in Figure 3.11.  

 

Also in this case, the radial distance stabilizes to a steady value and so the system reaches 

a stable configuration. Moreover, the radial distance of the spheres and of the ellipsoids 

Figure 3.11. Trend of the radial distance vs. time for the E/S configuration for the 

mixture of spheres and ellipsoids with AR=3.5; the graph was obtained by averaging 

the values of distance of the three tests (ω=4.22 rpm; filling level= 25%; the initial 

configuration was the E/S one). 
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Figure 3.10. Coordinates of the centre of mass for the spherical particles at a) t=10 min; 

b) t=30 min (test 1). 
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settles to different values, meaning that particles does not mix completely and some level 

of segregation occurs. 

The accumulation of the elongated particles at the centre of the granular bed is shown 

also by the trend of the distance of the two types of particles from the barycentre of the 

granular bed. 

 

The distance of the ellipsoids from the barycentre of the bed settles to very low values, 

indicating that the non-spherical particles are on average at the centre of the granular bed. 

The normalized distribution of the radial distance could be obtained only for the spherical 

particles, since the elongated ones were not individually identifiable. 

Figure 3.12. Distance from the barycentre of the bed vs. time for the spheres and 

the ellipsoids with AR 3.5 (ω=4.22 rpm; φ= 25%; the initial configuration was the 

E/S one), 
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The distribution shows that the number of spheres at distance lower that 80 mm is very 

low, since in this region of the granular bed the ellipsoids accumulate. The spheres are, 

instead, present in higher number at larger distances. 

To evaluate how fast the system is in reaching the steady configuration, the drum was 

rotated for two minutes and the radial distance was plotted in time. 

 

Figure 3.14. Trend of the radial distance vs. time for the 2 minutes test performed 

with the mixture of spheres and ellipsoids with AR=3.5 (ω=4.22 rpm; filling 

level= 25%). 
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Figure 3.13. Distribution of the radial distance of the spheres, obtained as the 

average of the distributions of the three tests. The histogram refers to the values 

of radial distance obtained at t=30 min (ω=4.22 rpm; filling level= 25%; the 

initial configuration was the E/S one). 
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After one minute, the radial distance reaches its steady value; so, the transition to the final 

configuration occurs quite fast. It has to be noted, however, that the transition is slower 

than the mixtures of spheres and ellipsoids with aspect ratio equal to 1.5. It takes more 

time for the binary mixture of spheres and more elongated particles to reach the steady 

configuration. 

Figure 3.15 shows some pictures of the drum, starting with S/E initial configuration.  

 

 

Also with a different initial configuration the more elongated particles accumulate at the 

centre of the granular bed and at lower distance from the centre of the drum. 

Figure 3.15. Drum at a) t=0; b) t=5 min; c) t=20 min; d) t=30 min (ω=4.22 rpm; 

φ= 25%; the initial configuration was the S/E one). 

 

a) b) 

c) d) 
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The trend of the radial distance for the inverted configuration is reported in Figure 3.16.  

 

Also for the binary mixture of spheres and more elongated ellipsoids it is found that the 

initial configuration of the particles does not affect the final state of the system, since the 

radial distance of the two types of particles settle to the same values, as shown in Figure 

3.16.  At the final time, the distribution of the distance of the spherical particles was 

obtained, showing that they are mainly found close to the drum wall. 
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Figure 3.16. Trend of the radial distance vs time for the two initial configurations. 

(ω=4.22 rpm; φ= 25%) 
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Figure 3.17. Distribution of the radial distance of the spheres. The histogram 

refers to the values of radial distance obtained at t=30 min (ω=4.22 rpm; φ= 25%; 

the initial configuration was the S/E one). 
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3.1.3 Spheres and ellipsoids AR=1.5, ω=4.22 rpm, φ=47% 

In order to evaluate the effect of the filling level of the drum, four tests were performed 

at the same conditions of speed but with higher filling level. The tests conditions are 

reported in Table 3.3. 

 

Table 3.3. Conditions of the tests with spheres and ellipsoids with AR=1.5 at higher filling level. 

AR 1 [-] AR 2 [-] ω [rpm] φ [-] initial configuration time [min] repetitions 

1 1.5 4.22 47% E/S 30 3 

1 1.5 4.22 47% S/E 30 1 

 

Figure 3.18 shows some images of the drum, at higher filling level; three tests were 

performed with the E/S initial configuration.  

 

Figure 3.18. Drum at a) t=0; b) t=5 min; c) t=15 min; d) t=30 min, (ω=4.22 

rpm; φ= 25%; the initial configuration was the E/S one). 
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The radial distance versus time is displayed in Figure 3.19. 

 

 

 

 

The trend of the radial distance of the two types of particles is the same of the one found 

at lower filling level, but moved to lower values, since the filling level is higher.  

The distribution of the spheres and of the ellipsoids at higher filling level is reported in 

Figure 3.20.  
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Figure 3.20. Distribution of the radial distance of the two types of particles, obtained 

as the average of the distributions of the three tests. The histogram refers to the values 

of radial distance obtained at t=30 min (ω=4.22 rpm; φ= 47%; the initial 

configuration was the E/S one). 

Figure 3.19. Trend of the radial distance vs. time for the E/S configuration for the 

mixture of spheres and ellipsoids with AR=1.5; the graph was obtained by averaging 

the values of distance of the three tests (ω=4.22 rpm; φ= 47%; the initial configuration 

was the E/S one). 
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At intermediate distances, a higher number of ellipsoids is found, while close to the wall 

the number of spheres is larger than the number of ellipsoids. 

The number composition of the spheres is reported in Figure 3.21. 

 

 

 

The composition of spheres is lower than the 50% for radial distance lower than 60 mm, 

meaning that at intermediate distances the number of ellipsoids is higher than the number 

of spherical particles. At distances larger than 90 mm, instead, the composition of spheres 

increases, indicating that the spherical particles tend mainly to settle close to the drum 

wall and so the mixture does not mix uniformly.  

Also at higher filling level, the effect of the initial configuration of the particles was 

investigated, running one test with the S/E initial configuration. The binary mixture is 

displayed in Figure 3.22 at different time instants.  
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Figure 3.21. Trend of the number composition of the spheres versus the radial 

distance, obtained as the average of the composition curve of the three tests 

(ω=4.22 rpm; φ= 47%; the initial configuration was the E/S one). 
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The distribution of the radial distance, obtained at the final time is illustrated in Figure 

3.23.  

 

Figure 3.22. Drum at a) t=0; b) t=5 min; c) t=15 min; d) t=30 min (test 1). 

(ω=4.22 rpm; φ= 47%; the initial configuration was the S/E one). 
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Figure 3.23. Distribution of the radial distance of the two types of particles; the initial 

configuration of the particles was the S/E one. The histogram refers to the values of radial 

distance obtained at t=30 min (ω=4.22 rpm; φ= 47%; the initial configuration was the 

S/E one). 
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The distribution shows again that the ellipsoids are mainly found at the centre of the 

granular bed, while the spheres are mainly at higher distances. 

The comparison of the two trends of the radial distance, depending on the initial 

configuration is shown in Figure 3.24.  

 

From Figure 3.24 it can be concluded that that the initial configuration does not affect the 

system, neither at higher filling level of the drum.  

3.1.4 Spheres and ellipsoids AR=3.5, ω=4.22 rpm, φ=47% 

At higher filling level of the drum, also the binary mixture of spheres and ellipsoids with 

aspect ratio equal to 3.5 was considered, as reported in Table 3.4. 

 

Table 3.4. Conditions of the tests with spheres and ellipsoids with AR=3.5 at higher filling level. 

AR 1 [-] AR 2 [-] ω [rpm] φ [-] initial configuration time [min] repetitions 

1 3.5 4.22 47% E/S 30 3 

1 3.5 4.22 47% S/E 30 1 
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Figure 3.24. Trend of the radial distance vs time for the two initial configurations. 
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The rotating drum at different time instants is shown in Figure 3.25. 

 

As for lower filling level, an accumulation of the more elongated particles at the centre 

of the solid bed is clearly observed; it is displayed also by plotting the coordinates of the 

centre of mass of the spherical particles:  

Figure 3.25. Drum at a) t=0; b) t=5 min; c) t=20 min; d) t=30 min (test 2). 

(ω=4.22 rpm; φ= 47%; the initial configuration was the S/E one). 
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Figure 3.26. Coordinates of the centre of mass for the spherical particles at a) t=5 min; 

b) t=20 min (test 2). 

a) b) 
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The trend of the radial distance versus time was found to be equal to the trend at lower 

filling level, but shifted at lower values.  

 

 

 

Moreover, the distance of the spheres and the ellipsoids from the barycentre of the be 

shows that the more elongated particles settle at the centre of the granular bed.  

Figure 3.27. Trend of the radial distance vs. time for the mixture of spheres and 

ellipsoids with AR=3.5; (ω=4.22 rpm; φ= 47%; the initial configuration was the E/S 

one); the graph was obtained by averaging the values of distance of the three tests. 

30

40

50

60

70

80

90

100

110

120

0 5 10 15 20 25 30

d
m

[m
m

]

time [min]

Spheres

Ellipsoids

0

10

20

30

40

50

60

70

80

0 5 10 15 20 25 30

d
m

,b
 [m

m
]

time [min]

Spheres
Ellipsoi…

Figure 3.28. Distance from the barycentre of the bed vs. time for the spheres and 

the ellipsoids with AR 3.5 (ω=4.22 rpm; φ= 47%; the initial configuration was 

the E/S one), 
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As it is shown, in fact, the distance of the more elongated particles from the barycentre 

of the grains is very low, indicating their tendency to settle at the centre.  

The same is shown by the distribution of the distance of the spheres.  

 

 

At distance from the centre of the drum lower than 70 mm, the number of spherical 

particles is very low, since there is an accumulation of the other type of particles. So, the 

behaviour of the binary mixture of spheres and elongated particles is found to be the same 

at the two different filling levels.  

Also, the inverted configuration S/E was considered (Figure 3.30). 

 

Figure 3.29. Distribution of the radial distance of the spheres, obtained as the 

average of the distributions of the three tests. The histogram refers to the values 

of radial distance obtained at t=30 min (ω=4.22 rpm; φ= 47%; the initial 

configuration was the E/S one). 
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The trend of the radial distance is illustrated in Figure 3.31, compared with the one 

obtained for the S/E initial configuration.  

 

Figure 3.30. Drum at a) t=0; b) t=5 min; c) t=20 min; d) t=30 min. (ω=4.22 

rpm; φ= 47%; the initial configuration was the S/E one). 

S/E one. 
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Figure 3.31. Trend of the radial distance vs time for the two initial 

configurations (ω=4.22 rpm; φ= 47%). 
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The graph of Figure 3.31 shows that the initial configuration again does not affect the 

final state of the system. Also in this case, in fact, the more elongated particles accumulate 

at lower distance from the centre of the drum; this is shown by the distribution of the 

spherical particles, too (Figure 3.32) 

3.1.5 Mixtures of ellipsoids (AR=1.5 and AR=3.5) 

Also, binary mixtures made of the two types of ellipsoids (AR=1.5 and AR=3.5) were 

taken into account at the same filling levels of the previous experimental tests and at the 

lower rotational speed. 

The experimental conditions are reported in Table 3.5.  

 

Table 3.5. Conditions of the tests with ellipsoids with AR=1.5 and AR=3.5. 

AR 1 [-] AR 2 [-] ω [rpm] φ [-] initial configuration time [min] repetitions 

1.5 3.5 4.22 25% E2/E1 30 3 

1.5 3.5 4.22 25% E1/E2 30 1 

1.5 3.5 4.22 25% E2/E1 2 1 

1.5 3.5 4.22 47% E2/E1 30 3 

1.5 3.5 4.22 47% E1/E2 30 1 

 

Some pictures of the mixture in the drum at lower filling level are shown in Figure 3.33.  
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Figure 3.32. Distribution of the radial distance of spheres, with the S/E initial 

configuration. The histogram refers to the values of radial distance obtained at 

t=30 min. 
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The trend of the radial distance of the two types of particles versus time is displayed in 

Figure 3.34. 
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Figure 3.33. Drum at a) t=0; b) t=10min; c) t= 25 min; d) t=30 min (test 3), 

(ω=4.22 rpm; φ= 25%; the initial configuration was the E2/E1 one). 

Figure 3.34. Trend of the radial distance vs. time for the mixture of ellipsoids (AR=1.5 

and AR=3.5); the graph was obtained by averaging the values of distance of the three 

tests (ω=4.22 rpm; φ= 47%; the initial configuration was the E2/E1 one). 
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As in the previous cases, the binary mixture reaches a steady state and settles to a stable 

condition.  

It has to be considered that, also in this case, the more elongated particles were not 

individually identifiable and so the distance distribution was defined only for the 

ellipsoids with AR=1.5; it is shown in Figure 3.35. 

 

The ellipsoids with AR=1.5 behave like the spheres in the previously considered 

mixtures. At lower distance, the more elongated particles are present in higher number, 

while the particles with lower aspect ratio are distributed in higher number close to the 

walls. So, also the two types of ellipsoids do not mix homogeneously and some level of 

segregation is observed. 

The inverted configuration was also considered; some images are reported in Figure 3.36. 
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Figure 3.35. Distribution of the radial distance of the ellipsoids with AR=1.5, 

obtained as the average of the distributions of the three tests. The histogram refers to 

the values of radial distance obtained at t=30 min (ω=4.22 rpm; φ= 25%; the initial 

configuration was the E2/E1 one). 
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The trend of the mean distance of the two types of particles shows that also with the two 

different initial configurations the same steady state is reached and so the initial 

configuration of the particles does not affect the final condition of the system.  

 

Figure 3.36. Drum at a) t=0; b) t=5min; c) t= 15 min; d) t=30 min, (ω=4.22 

rpm; φ= 25%; the initial configuration was the E1/E2 one). 

a) b) 

c) d) 
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Figure 3.37. Trend of the radial distance vs time for the two initial 

configurations (ω=4.22 rpm; φ= 25%). 
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The distribution of the distance of the less elongated ellipsoids (Figure 3.38) shows that 

a uniform mixing of the particles does not occur, since the ellipsoids with AR=1.5 are 

present in higher number at larger distances; at distance lower than 70 mm a high number 

of more elongated particles is found. The ellipsoids with AR=1.5, instead, are found in 

higher number at d=80 mm and for distances between 100 and 110 mm.  

 

Moreover, from Figures 3.34 and 3.37 it can be seen that after one minute the system 

already reaches the final stable state. So, the transition to the final configuration occurs 

fast as it is, in fact, reported in Figure 3.39. 

 

 

Figure 3.38. Distribution of the radial distance ellipsoids with AR=1.5. The histogram 

refers to the values of radial distance obtained at t=30 min (ω=4.22 rpm; φ= 25%; the 

initial configuration was the E1/E2 one). 
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After 30 seconds, the radial distance settles to the steady value; the same occurred with 

the binary mixture made of spheres and ellipsoids with AR=1.5. 

The mixture at higher filling level is shown in Figure 3.40. 

 

Figure 3.40. Drum at a) t=0; b) t=5min; c) t= 15 min; d) t=30 min, (test 2) 

(ω=4.22 rpm; φ= 47%; the initial configuration was the E2/E1 one). 

 

Figure 3.39. Trend of the radial distance vs. time for the 2 minutes test (ω=4.22 

rpm; φ= 25%). 
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The radial distance plotted versus time (Figure 3.41) shows again that a stable state is 

reached in time. 

 

The distribution of the ellipsoids with AR=1.5 in Figure 3.42 shows that the less elongated 

particles are mainly distributed at higher distances, so closer to the drum wall. 
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Figure 3.42. Distribution of the radial distance of the ellipsoids with AR=1.5, 

obtained as the average of the distributions of the three tests. The histogram refers to 

the values of radial distance obtained at t=30 min (ω=4.22 rpm; φ= 47%; the initial 

configuration was the E2/E1 one). 

 

Figure 3.41. Trend of the radial distance vs. time for the mixture of ellipsoids (AR=1.5 and 

AR=3.5); the graph was obtained by averaging the values of distance of the three tests 

(ω=4.22 rpm, φ= 47%; the initial configuration was the E2/E1 one). 
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The binary mixture in the drum at higher level and starting with the E1/E2 configuration 

is shown in Figure 3.43.  

 

The trend of the radial distance and is reported in the following image. 

a) b) 

Figure 3.43. Drum at a) t=0; b) t=1 min; c) t= 15 min; d) t=30 min, (ω=4.22 

rpm; φ= 47%; the initial configuration was the E1/E2 one). 

 

c) d) 
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Figure 3.44. Trend of the radial distance vs time for the two initial 

configurations (ω=4.22 rpm; φ= 47%). 
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So, also for the binary mixture of the two types of particles the filling level of the drum 

and the initial configuration do not affect the final configuration.  

3.1.6 Spheres and ellipsoids AR=1.5, ω=11.5 rpm 

The experimental tests at higher rotational speed were run at the condition reported in 

Table 3.6. 

 

Table 3.6. Conditions of the tests with spheres and ellipsoids with AR=1.5 at higher rotational speed. 

AR 1 [-] AR 2 [-] ω [rpm] φ [-] initial configuration time [min] repetitions 

1 1.5 11.51 25% E/S 30 3 

1 1.5 11.51 47% E/S 30 3 

 

The filling levels of the drum were the same ones considered at lower rotational speed.  

At lower filling level (25%) the trend of the radial distance was found to be the same of 

the one found at lower rotational speed, as shown in Figure 3.46. 
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Figure 3.45. Distribution of the radial distance ellipsoids with AR=1.5. The histogram 

refers to the values of radial distance obtained at t=30 min (ω=4.22 rpm; φ= 25%; the 

initial configuration was the E1/E2 one). 
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So, also when the drum rotates at higher speed, a steady condition in reached by the binary 

mixture. 

Moreover, from the distribution of the radial distance obtained (Figure 3.47) for the two 

types of particles it is verified that again the particles do not mix uniformly. 
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Figure 3.47. Distribution of the radial distance of the two types of particles, obtained 

as the average of the distributions of the three tests. The histogram refers to the values 

of radial distance obtained at t=30 min (ω=11.51 rpm; φ= 25%; the initial 

configuration was the E/S one). 

 

Figure 3.46. Trend of the radial distance vs time for the two rotational speeds of 

the drum (binary mixture of spheres and ellipsoids with AR=1.5, φ= 25%). 
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At intermediate distance, in fact, the number of ellipsoids is higher than the number of 

spheres, especially for distances between 70 and 100 mm; the spherical particles are 

higher in number very close to the wall.  

Also at higher filling level (47%) the behaviour was the same observed at lower rotational 

speed: the radial distance settle to a steady value and the particles are found not to 

uniformly mixed, as displayed from the distribution of Figure 3.49. 
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Figure 3.48. Trend of the radial distance vs time for the two rotational speeds of the 

drum (binary mixture of spheres and ellipsoids with AR=1.5, φ= 47%). 
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Figure 3.49. Distribution of the radial distance of the two types of particles, obtained 

as the average of the distributions of the three tests. The histogram refers to the values 

of radial distance obtained at t=30 min (ω=11.51 rpm; φ= 47%; the initial 

configuration was the E/S one). 
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The distribution shows that a high number of ellipsoids settles at intermediate distance 

from the centre of the drum, between 50 and 80 mm and so that the non-spherical particles 

are distributed, on average, at a lower distance than the spherical particles.  

Since at higher rotational velocity the behaviour of the binary mixture is the same found 

when the drum rotates at lower speed, the drum speed seems not to be a parameter 

affecting the system.  

3.1.7 Spheres and ellipsoids AR=3.5, ω=11.5 rpm 

The binary mixture of spheres and ellipsoids with AR=3.5 was tested at higher rotational 

speed of the drum, at the conditions specified in Table 3.7.  

 

Table 3.7. Conditions of the tests with spheres and ellipsoids with AR=3.5 at higher rotational speed. 

AR 1 [-] AR 2 [-] ω [rpm] φ [-] initial configuration time [min] repetitions 

1 3.5 11.51 25% E/S 30 3 

1 3.5 11.51 47% E/S 30 3 

 

At the two rotational speeds, the same steady state is reached; so, also for this binary 

mixture the speed of the drum does not affect the final configuration.  

At the two rotational speeds, the same steady state is reached; so, also for this binary 

mixture the speed of the drum does not affect the final configuration.  
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Figure 3.50. Trend of the radial distance vs time for the two rotational speeds of the 

drum (binary mixture of spheres and ellipsoids with AR=3.5, φ=25%). 
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Moreover, the more elongated particles are found to accumulate at the centre of the 

granular bed and at lower distance from the centre of the drum, as shown from the 

distribution.  

 

At higher filling level, the same behaviour is observed. 
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Figure 3.51. Distribution of the radial distance of the spheres, obtained as the average 

of the distributions of the three tests. The histogram refers to the values of radial distance 

obtained at t=30 min (ω=11.51 rpm; φ= 25%; the initial configuration was the E/S one). 
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Figure 3.52. Trend of the radial distance vs time for the two rotational speeds of the 

drum (binary mixture of spheres and ellipsoids with AR=3.5, φ= 47%). 
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3.1.8 Discussion 

From the experimental tests described in the previous paragraphs, it was found that binary 

mixtures of particles with different shape but with the same volume do not mix uniformly 

and segregation was observed. In particular, the particles with lower aspect ratio tend to 

stay closer to the drum walls, while the more elongated particles are found, on average, 

mainly at the centre of the granular bed.  

The most significant case is represented by the mixture of spheres and ellipsoids with 

AR=3.5; for this mixture, in fact, the segregation is more evident and the non-spherical 

particles clearly accumulate in the centre of the granular bed. This behaviour can be 

explained considering that mixing and segregation phenomena in the system occur in the 

so-called active layer; during the motion of the drum, it was observed that the particles 

with AR=3.5 move in parallel to the granular surface and so they are not able to pass 

through the void existing between the spherical particles, due to their elongated shape and 

to their orientation. Therefore, the more elongated particles accumulate on the surface. It 

has to be considered that the mixture of spheres and ellipsoid with AR=3.5 is, among the 

three considered mixtures, the one that presents the higher difference in shape of its 

particles. Due to the higher difference in shape, segregation is more evident.  

However, the other two binary mixture showed some level of segregation too.  
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Figure 3.53. Distribution of the radial distance of the spheres, obtained as the average 

of the distributions of the three tests. The histogram refers to the values of radial distance 

obtained at t=30 min (ω=11.51 rpm; φ= 47%; the initial configuration was the E/S one). 
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In the case of mixtures of spheres and ellipsoids with AR=1.5 it was shown that the 

particles did not mix homogeneously, even if the difference in shape is low; the ellipsoids 

displayed a tendency to settle at the centre of the granular bed, while the spherical 

particles tended to stay closer to the drum walls.  

A not uniform mixing of particles was observed also when the binary mixtures made of 

ellipsoids with AR=1.5 and ellipsoids with AR=3.5 was considered. The ellipsoids with 

lower aspect ratio were found to behave similarly to the spherical particles in the other 

two mixtures; again, it was found that the more elongated particles tend to settle at the 

centre of the granular bed. The formation of a clear accumulation of more elongated 

particles was not observed (like it was for the binary mixture of spheres and more 

elongated ellipsoids) and so the degree of segregation was lower, considering that the 

difference in shape was smaller. 

Furthermore, from the trends of the mean radial distance of the particles it was shown 

that the three mixtures reach a stable configuration. So, the observed segregation is not a 

transient phenomenon that vanish after a while, since the segregated configuration is, in 

fact, kept in time.  

When the initial configuration of the particles was inverted, the final configuration of the 

system was found to be the same. Also, the filling level of the drum and its rotational 

speed did not affect the final steady state of the mixtures. The particles showed the same 

behaviour at different filling levels and rotational speed of the drum. Therefore, these two 

operative variables were found not to affect the phenomena occurring in the rotating 

drum.  

The comparison of the behaviour of the mixtures at the two filling levels can be carried 

out by normalizing the mean radial distance dm of the two types of particle on the mean 

distance of all the particles dc, calculated according to formula (2.16). The trend of dm/dc 

versus time for the three binary mixtures is shown in the following images: 
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Figure 3.56. dm/dc vs. time for the mixture of ellipsoids with AR=1.5 

and ellipsoids with AR=3.5. 

 

Figure 3.54. dm/dc vs. time for the mixture of spheres and ellipsoids with 

AR=1.5. 

Figure 3.55. dm/dc vs. time for the mixture of spheres and ellipsoids with 

AR=3.5. 
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In the case of mixture of spheres and ellipsoids with AR=1.5, the curves at different filling 

levels overlap, showing that the behaviour of the mixture is not affected by the filling 

levels of the drum. In the case of the other two mixtures, the curves do not overlap exactly, 

especially in the case of the binary mixture of spheres and ellipsoids with AR=3.5. 

However, the difference between the curves at different filling levels is not very high. 

3.2 Mixtures of particles of different sizes 

In this paragraph, the results of the tests performed with mixtures made of particles of 

different sizes will be presented. It is reminded that, in these tests, the number of particles 

was defined in order to have binary mixtures with a composition of the 50% of both the 

components on a base volume and a filling level as equal as possible to 25%.  

3.2.1 Spheres with 8 mm and 3.81 mm diameter 

The conditions at which the test with 8 mm and 3.81 mm diameter particles was 

performed are reported in Table 3.8. 

 
Table 3.8. Rotational speed, filling level, number of particles and volume composition of the test. 

ω 

[rpm] 
φ % [-] 

N big 

spheres [-] 

V big spheres 

[cm3] 

N small 

particles [-] 

V small 

spheres [cm3] 

4.22 24.734 115 30.829 1100 31.854 

 

As it is known from the literature, particles of different sizes tend to segregate and the 

phenomenon occurs quite fast. This was observed in practice; the formation of a 

segregated core, in fact, is shown in Figure 3.57.  

 

a) 

Figure 3.57. a) Drum at the initial condition; b) drum at t=23 s; c) drum at t=120 s. 

a) b) c) 
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From the pictures reported above it can be seen that percolation is not absent at all in this 

case and some small particles accumulate close to the drum wall, too.  

The accumulation of small particles at the centre of the granular bed can be illustrated by 

plotting the coordinates of the centre of mass of the bigger spheres, as shown in the 

following pictures. 

 

The empty space at the centre of the granular bed is the space unoccupied by the big 

spheres, where the smaller particles accumulate. Moreover, the radial distance from the 

centre of the drum (d) of the big spheres was calculated at different time instants and the 

difference (d0-d) was plotted in time, where d0 is the radial distance of the big spheres at 

the initial time. The trend is displayed in the following figure. 
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Figure 3.58. Plot of the coordinates of the centre of mass of 8 mm spheres at a) t= 23s and 

b) t=120 s. 
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Figure 3.59. (d0-d) vs time; the radial distance is the one of 8 mm spheres. 
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The plot shows that a steady state is reached and the transition to the final value is quite 

fast. As shown previously, in fact, after 23 seconds the system displays a clear segregation 

that is then kept in time. The oscillations that the trend exhibits at the first seconds are 

due to the initial motion of the particles before reaching the final steady state value, as 

Figure 3.60 shows.  

 

Starting from the segregated initial configuration, the particles move and at the very 

beginning the two types of particles distribute in an opposite way. Then, the segregated 

core is formed, as shown before.  

3.2.2 Spheres with 8 mm and 6 mm diameter 

In the same conditions of the previous test but with different small spherical particles 

another test was performed. The test conditions are reported in Table 3.9. 

 
Table 3.9. Rotational speed, filling level, number of particles and volume composition of the test.  

ω 

[rpm] 
φ % [-] 

N big 

spheres [-] 

V big spheres 

[cm3] 

N small 

particles [-] 

V small 

spheres [cm3] 

4.22 24.915 95 25.468 219 24.768 

Figure 3.60. a) Drum at t=10 s; b) drum at t=13.7 s. 

a) b) 
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Also in this case, the smaller particles tend to settle and the centre of the granular bed. 

However, the formation of a segregated core is less noticeable, as it can also be seen by 

plotting the coordinates of the bigger spheres.  
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Figure 3.62. Plot of the coordinates of the centre of mass of 8 mm spheres at a) t= 23s 

and b) t=120 s 

 

Figure 3.61. a) Drum at the initial condition; b) drum at t=23 s; c) drum at t=120 s. 

a) b) c) 
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The trend of the difference (d0-d) is reported in Figure 3.63.  

 

As for the mixture previously considered, a steady state is reached, meaning that the 

mixture stabilizes at a steady condition. Moreover, it can be noticed that after 30 seconds 

the steady state is already reached, indicating that the achievement of the stable condition 

for the system is quite fast. 

3.2.3 Comparison and discussion  

To compare the behaviour of the two binary mixtures the distance of the big spheres is 

normalized on the distance of the barycentre of the bed from the centre of the drum (dc) 

and d/dc is plotted versus time. The two trends are displayed together in the following 

image. 

Figure 3.63. (d0-d) vs time; the radial distance is the one of 8 mm spheres. 
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As it can be seen, in the case of the binary mixture of 8 mm spheres and 3.81 mm particles, 

the variation of the normalized radial distance of the bigger spheres with respect to the 

initial value is not very high; considering that the bigger spheres at the initial time were 

below the smaller particles and closer to the drum wall, the trend indicates that the big 

spheres tend to keep a larger radial distance and so to stay closer to the drum wall, as it is 

in fact observed. The smaller particles, instead, mainly accumulate at lower radial 

distance, forming a segregated core. As it is known, the motion of the particles occurs 

only on the surface layer of the granular bed (active layer) and the remaining part of the 

particles moves as a solid bed. Since voids exist between the big particles during the 

motion along the surface, the small particles can easily pass through them; however, the 

deeper big particles are not in motion and so the smaller particles cannot further penetrate 

in the granular bed and accumulate more superficially.  

When 8 mm spheres are placed with 6 mm spheres, instead, the variation of their 

normalized radial distance is higher. It means that the big spheres have on average a lower 

distance from the centre of the drum; they change their position from the initial one more 

than in the previous case and so a higher mixing of particles occurs. The formation of a 

clear segregated core is, in fact, not observed with this binary mixture, since, due to the 

lower difference in size, the 6 mm spheres can pass through the voids between the big 

spheres less easily.  

In conclusion, higher is the difference in size of the particles and greater is the observed 

segregation. When the difference in particle size is lower, instead, particles are more 

easily mixed. So, the size ratio between the particles constituting the mixture affects the 

mixing process in the rotating drum and for high size ratios segregation clearly occurs.  

3.3 Evaluation of Maximum Angle of Stability, Angle of Repose 

and Dynamic Repose Angle 

The Maximum Angle of Stability (αmax), the Angle of Repose (β) and the Dynamic 

Repose Angle (βd) were evaluated, with the two methods described in the previous 

chapter (see § 2.6.3), for all the mixtures considered in this work. 

Three values of each angle were estimated with the two methods and the final value was 

then obtained as the mean value of the three calculated ones.  
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The drum was rotated at 4.22 rpm, with a filling level of the 25% for all the experiments 

performed for the angle evaluation.  

 

• Mixture of spheres and ellipsoids with AR=1.5 

Figure 3.65 shows an example of images used for the evaluation of Maximum 

Angle of Stability and the Angle of Repose for the binary mixture.  

 

The values of angles obtained with the two methods are reported in Table 3.10. 

 

 Table 3.10. Maximum Angle of Stability and Angle of Repose evaluated with Method 1 and Method 2.  

Mixture of spheres and ellipsoids with AR=1.5 

Method 1 Method 2 

 αmax [degrees] β [degrees] αmax [degrees] β [degrees] 

1 41.130 30.390 44.230 32.840 

2 40.160 31.150 40.760 29.583 

3 41.980 31.090 44.663 29.080 

mean 41.090 30.887 43.218 30.501 

STD [degrees] 0.744 0.345 1.747 1.667 

 

The values obtained with the two methods are very similar. So, in this case both the 

methods are reliable for the angle evaluation.  

Figure 3.65. Example of images used for the evaluation of a) the Maximum Angle of 

Stability and b) the Angle of Repose for the mixtures of spheres and ellipsoids with 

AR=1.5. 

a) b) 
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The Dynamic Angle of Repose was calculated considering the particles in motion, as 

reported in Figure 3.66. 

 

The values of the angle obtained with the two methods are reported in Table 3.11. 

 

Table 3.11. Dynamic Angle of Repose evaluated with Method 1 and Method 2. 

Mixture of spheres and ellipsoids with AR=1.5 

 Method 1 Method 2 

 βd [degrees] βd [degrees] 

1 36.830 38.969 

2 36.630 38.477 

3 36.160 35.615 

mean 36.540 37.687 

STD [degrees] 0.281 1.479 

 

The values of the Dynamic Angle of Repose calculated with the two methods are very 

similar. 

Moreover, the values of Table 3.11 can be compared with the ones obtained calculating 

the angle as the average of αmax and β. 

 

 

 

 

 

Figure 3.66. Example of image used for the evaluation of the Dynamic 

Angle of Repose for the mixtures of spheres and ellipsoids with AR=1.5. 
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Table 3.12. Dynamic Angle of Repose calculated as the average of αmax and β. 

Mixture of spheres and ellipsoids with AR=1.5 

 Method 1 Method 2 

 βd [degrees] βd [degrees] 

1 35.760 38.535 

2 35.655 35.172 

3 36.535 36.872 

mean 35.983 36.859 

STD [degrees] 0.392 1.373 

 

The values of angle of Tables 3.11 and 3.12 are very similar, differing only for one degree; 

this confirms that the Dynamic Angle of Repose is computable as the average of the 

Maximum Angle of Repose and the Angle of Repose.  

Furthermore, considering a complete avalanche of the mixture, the value of the angle can 

be plotted in time.  

 

The time instant at which the Maximum Angle of Stability is reached is assumed to be 

the initial time instant (t=0). A periodic trend is shown: starting from the maximum angle, 

after about one second, the angle reaches its minimum value and afterwards the mixture 

starts to rise again in the drum, and the value of angle returns to maximum one. It takes 

only three seconds to see a complete avalanche.  
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Figure 3.67. Angle of the surface of the granular bed vs. time (spheres and 

ellipsoids with AR=1.5). 
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• Mixture of spheres and ellipsoids with AR=3.5 

Two of the images used for the estimation of the angles are reported in Figure 

3.68. 

 

 

Table 3.13 contains the calculated values of angle with the two methods. 

 

Table 3.13. Maximum Angle of Stability and Angle of Repose evaluated with Method 1 and Method 2. 

Mixture of spheres and ellipsoids with AR=3.5 

Method 1 Method 2 

 αmax [degrees] β [degrees] αmax [degrees] β [degrees] 

1 47.290 35.770 53.108 35.300 

2 47.160 36.520 49.140 35.560 

3 47.410 35.710 52.183 36.688 

mean 47.287 36.000 51.477 35.846 

STD [degrees] 0.102 0.369 1.695 0.598 

 

It has to be noted that in this case the values of the Maximum Angle of Stability obtained 

with the two methods are slightly different. The particles surface was in many cases not 

exactly flat and the fitting by the straight line was not exactly precise. Moreover, the value 

of the angles for the mixture of spheres and ellipsoids with AR=3.5 are higher than the 

ones of the mixtures of spheres and ellipsoids with AR=1.5. The mixtures with more 

elongated particles are, in fact, able to develop more stable structures that can reach a 

higher angle before the particles start sliding along the surface.  

Figure 3.68. Example of images used for the evaluation of a) the Maximum Angle of 

Stability and b) the Angle of Repose for the mixtures of spheres and ellipsoids with AR=3.5 

a) b) 
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The Dynamic Angle of Repose was evaluated considering the particles in motion 

 

 

The values of βd obtained with the two methods are reported in Table 3.14. 

 

Table 3.14. Dynamic Angle of Repose evaluated with Method 1 and Method 2. 

Mixture of spheres and ellipsoids with AR=3.5 

 Method 1 Method 2 

 βd [degrees] βd [degrees] 

1 40.050 42.101 

2 40.560 37.730 

3 41.020 40.754 

mean 40.543 40.195 

STD [degrees] 0.396 1.828 

 

These values can be compared with the ones obtained evaluating the same angle 

according to formula (2.23). 

 

Table 3.15. Dynamic Angle of Repose calculated as the average of αmax and β. 

Mixture of spheres and ellipsoids with AR=3.5 

 Method 1 Method 2 

 βd [degrees] βd [degrees] 

1 41.530 44.204 

2 41.840 42.350 

3 41.560 44.431 

mean 41.643 43.662 

STD [degrees] 0.140 0.932 

Figure 3.69. Example of image used for the evaluation of the Dynamic 

Angle of Repose for the mixtures of spheres and ellipsoids with AR=3.5. 
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Also in this case the difference between the values of βd of Table 3.14 and 3.15 is low.  

The trend of the angle versus time, for a complete avalanche is shown in the following 

image.  

 

As in the previous case, a complete avalanche occurs in three seconds.  

 

• Mixture of ellipsoids with AR=1.5 and ellipsoids with AR=3.5 

In Figure 3.71 some pictures of the two angles for the mixtures made of the two 

types of ellipsoids are shown.  

Figure 3.71. Example of images used for the evaluation of a) the Maximum Angle of 

Stability and b) the Angle of Repose for the mixtures of ellipsoids with AR=1.5 and 

ellipsoids with AR=3.5. 
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Figure 3.70. Angle of the surface of the granular bed vs. time (spheres and 

ellipsoids with AR=3.5). 

a) b) 
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The estimated values of the angles are reported in the following table. 

 

Table 3.16. Maximum Angle of Stability and Angle of Repose evaluated with Method 1 and Method 2. 

Mixture of ellipsoids AR=1.5 and ellipsoids with AR=3.5 

Method 1 Method 2 

  αmax [degrees] β [degrees] αmax [degrees] β [degrees] 

1 47.700 38.540 56.038 43.111 

2 50.090 42.170 48.658 39.275 

3 51.500 40.900 52.378 42.498 

mean  49.763 40.537 52.357 41.628 

STD [degrees] 1.568 1.504 3.014 1.682 

 

Also in this case, Method 1 was less accurate for the evaluation of the Maximum Angle 

of Stability, since the granular surface is in some cases not exactly flat. 

The Dynamic Angle of Repose was also evaluated. 

 

It was verified that the values of the angle computed from images of the particles in 

motion (Table 3.17) were very similar to the values obtained according to formula (2.23) 

(Table 3.18). 

 

 

 

Figure 3.72. Example of image used for the evaluation of the Dynamic 

Angle of Repose for the mixtures of ellipsoids with AR=1.5 and ellipsoids 

with AR=3.5. 
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Table 3.17. Dynamic Angle of Repose evaluated with Method 1 and Method 2. 

Mixture of ellipsoids AR=1.5 and ellipsoids with AR=3.5 

 Method 1 Method 2 

 βd [degrees] βd [degrees] 

1 41.790 45.561 

2 45.710 46.787 

3 43.650 48.256 

mean 43.717 46.868 

STD [degrees] 1.601 1.102 

 

 

Table 3.18. Dynamic Angle of Repose calculated as the average of αmax and β. 

Mixture of ellipsoids AR=1.5 and ellipsoids with AR=3.5 

 Method 1 Method 2 

 βd [degrees] βd [degrees] 

1 43.120 49.574 

2 46.130 43.965 

3 46.200 47.438 

mean 45.150 46.993 

STD [degrees] 1.436 2.312 

 

The trend of the angle versus time for the mixture made of the two types of ellipsoids is 

reported in Figure 3.73. 
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Figure 3.73. Angle of the surface of the granular bed vs. time (ellipsoids with 

AR=1.5 and AR= 3.5) 
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For the mixture of ellipsoids, the trend of the angle is more oscillating before the 

minimum value is reached. Also, it takes more time (almost four seconds) for the angle 

to return to the maximum value.  

Furthermore, the obtained values of angle for the mixtures of the two types of ellipsoids 

are the highest ones among the three mixtures of differently shaped particles that were 

taken into account.  

The values of the two angles for the three mixtures are visually shown in the following 

histograms. 

The evaluation of the angles for the three mixtures highlights that different behaviours 

occur according to particles shape. As it was already said, the elongated particles are able 

to partly overlap each other and, due to their shape and also due to the presence of the 

drum walls, the mixtures they form are more stable. Consequently, the Maximum Angle 

of Stability and the Angle of Repose assume higher values for the mixtures containing 

particles with AR=3.5. Moreover, the mixture made of ellipsoids with AR=1.5 and 

AR=3.5 demonstrate even higher angles. This means again that non-spherical particles 

give more stable mixtures due to their shape.  
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• Spheres with 8 mm and particles with 3.81 mm diameter 

The formed by the binary mixtures are illustrated in Figure 3.75. 

 

 

The values of angles are reported in the following table: 

 

Table 3.19. Maximum Angle of Stability and Angle of Repose evaluated with Method 1 and Method 2. 

Mixture of 8 mm spheres and 3.81 mm particles 

Method 1 Method 2 

 αmax [degrees] β [degrees] αmax [degrees] β [degrees] 

1 38.750 36.750 39.327 37.282 

2 38.380 36.510 38.259 36.658 

3 38.590 36.340 38.431 35.983 

mean 38.573 36.533 38.672 36.641 

STD [degrees] 0.152 0.168 0.468 0.530 

 

The values obtained with the two methods are very similar. Moreover, the difference 

between the Maximum Angle of Stability and the Angle of Repose is very low. The angle 

that the granular bed forms in the drum does not change very much during the motion, 

meaning that with mixture of particles of the same shape the motion is more regular and 

stable.  

The Dynamic Angle of Repose was evaluated from pictures of the mixture in motion. An 

example is displayed in Figure 3.76. 

 

Figure 3.75. Example of images used for the evaluation of a) the Maximum Angle of 

Stability and b) the Angle of Repose for the mixtures of 8 mm spheres and 3.81 mm 

particles. 

 

a) b) 
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The values of the Dynamic Angle of Repose computed as before are reported in Table 

3.20 and 3.21. 

 

Table 3.20. Dynamic Angle of Repose evaluated with Method 1 and Method 2. 

Mixture of 8 mm spheres and 3.81 mm particles 

 Method 1 Method 2 

 βd [degrees] βd [degrees] 

1 37.180 39.054 

2 37.670 37.118 

3 37.750 38.170 

mean 37.533 38.114 

STD [degrees] 0.252 0.791 

 

Table 3.21. Dynamic Angle of Repose calculated as the average of αmax and β. 

Mixture of 8 mm spheres and 3.81 mm particles 

 Method 1 Method 2 

 βd [degrees] βd [degrees] 

1 37.750 38.304 

2 37.455 37.459 

3 37.465 37.207 

mean 37.553 37.657 

STD [degrees] 0.139 0.469 

 

The values obtained are very similar, confirming the validity of formula (2.23). 

 

Figure 3.76. Example of image used for the evaluation of the Dynamic 

Angle of Repose for the mixtures of 8 mm spheres and 3.81 mm particles. 
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• Spheres with 8 mm and 6 mm diameter  

An example of angles is reported below. 

 

Table 3.22 reports the calculated values of αmax and β. 
 

Table 3.22. Maximum Angle of Stability and Angle of Repose evaluated with Method 1 and Method 2 

Mixture of 8 mm spheres and 6 mm spheres 

Method 1 Method 2 

 αmax [degrees] β [degrees] αmax [degrees] β [degrees] 

1 37.240 35.720 36.012 33.817 

2 37.180 35.280 37.041 30.809 

3 37.840 32.590 37.100 30.803 

mean 37.420 34.530 36.717 31.809 

STD [degrees] 0.298 1.383 0.499 1.419 

 

The angles calculated with the two methods are slightly different in this case; also, the 

angles for this binary mixture are slightly lower than the angles calculated for the other 

binary mixture of differently sized particles.  

The Dynamic Angle of Repose was calculated, too. 

 

 

 

 

 

Figure 3.77. Example of images used for the evaluation of a) the Maximum Angle 

of Stability and b) the Angle of Repose for the mixtures of 8 mm spheres and 6 mm 

spheres. 

 

a) b) 
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The values of the Dynamic Angle of Repose are presented in the following tables. 

 

Table 3.23. Dynamic Angle of Repose evaluated with Method 1 and Method 2. 

Mixture of 8 mm spheres and 6 mm spheres 

 Method 1 Method 2 

 βd [degrees] βd [degrees] 

1 34.720 34.415 

2 35.320 33.771 

3 37.730 33.910 

mean 34.923 34.032 

STD [degrees] 0.281 0.277 

 

Table 3.24. Dynamic Angle of Repose calculated as the average of αmax and β. 

Mixture of 8 mm spheres and 6 mm spheres 

 Method 1 Method 2 

 βd [degrees] βd [degrees] 

1 36.480 34.915 

2 36.230 33.925 

3 35.215 33.951 

mean 35.975 34.263 

STD [degrees] 0.547 0.461 

 

 

It has to be noted that the Maximum Angles of Stability calculated for the mixtures of 

particles with different size are significantly lower than the ones obtained for the mixtures 

of differently shaped particles, especially with respect to the values obtained for the 

Figure 3.78. Example of image used for the evaluation of the Dynamic 

Angle of Repose for the mixtures of 8 mm spheres and 6 mm spheres. 
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mixtures containing the more elongated particles. This suggest that with particles of the 

same shape the motion in the drum is different; the maximum angle that the granular bed 

reaches before one avalanche occurs is lower so the mixtures form less stable structures 

and flow more easily in the rotating drum.  

So, also from the angle evaluation it can be concluded that the particles shape has a strong 

influence on the mixture behaviour un the drum.



 

 

Conclusions 

The aim of this work was the study of mixing and segregation phenomena occurring in a 

rotating drum loaded with particles of different shapes. Two types of ellipsoids were used 

as non-spherical particles; they were considered together with spherical particles having 

the same volume.  

It was shown that shape segregation phenomena are not transient ones, but the segregated 

configurations reached by the considered mixtures are kept in time. The phenomenon 

occurs also when the difference in shape is very low and it does not depend neither on the 

initial configuration of the system nor on the filling level of the drum and its rotational 

speed. Furthermore, shape segregation occurs very fast and the kinetic of the phenomenon 

is comparable to the one of size segregation phenomena.  

The influence of the particles shape was also underlined by the calculation of the 

Maximum Angle of Stability, the Angle of Repose and the Dynamic Angle of Repose. 

Mixtures of differently sized particles show lower values of angles than the mixtures of 

differently shaped particles. The shape of the particle strongly influences the dynamics of 

the mixture in the drum and mixtures of differently shaped particles can develop stable 

structures showing high values of angles. Also, among the three mixtures made of 

particles of different shapes, the one made of the two types of non-spherical particles 

shows the highest values of angles, indicating that when both the components in the 

mixtures are non-spherical the dynamic is even different. 

As a conclusion, the shape is a relevant particles property not only with respect to the 

mixing process but also with respect to the dynamic of the particle in the rotating drum. 

Considering the relevance of non-spherical particles in common practical application, the 

phenomenon has to be clearly taken into account and further investigated to completely 

characterize it.  

The study was limited to radial phenomena and has considered two types of non-spherical 

particles only. As next steps, also different geometries of the drum should be considered; 

in particular, increasing the thickness of the drum would allow to investigate also axial 

phenomena. Moreover, the study should be extended also to other types of non-spherical 

particles. 



 

 



 

 

 

Appendix  

In this Appendix, some information about the ImageJ program are reported; they can be 

useful to better understand the image processing procedure followed in this work and 

presented in Chapter 2.  Also, the main options and plugins used for the image analysis 

are described.  

ImageJ is an open source Java image processing program that allows to display, modify, 

process and save 8-bit, 16-bit and 32-bit pictures.  

The program has thousands of plugins that extend its functionality. Some of them are 

already installed, some can be installed from the ImageJ update site and some more can 

be manually installed from online sources.  

When the program runs, the main ImageJ window opens. The window presents eight 

menus: File, Edit, Image, Process, Analyze, Plugins, Windows and Help, as shown in 

Figure A1.  

 

 

Figure A1. ImageJ interface. 

 

Image types 

Digital images are two-dimensional grids of pixel intensities values; the width and height 

of the image are defined by the number of pixel in x (rows) and y (columns) directions. 

Pixels are the smallest single components of images, with a numeric value – pixel 

intensity – that range between black and white. In this range, the number of unique 

intensity vales that can exist in the image is defined as the bit-depth of the image and 

specifies the level of precision in which intensities are coded. For example, a 2-bit image 

has 22= 4 tones, a 4-bit image has 24= 16 tones.  

In terms of bits per pixels (bpp), the main types of images are: 
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• 8-bit: images that can display 28= 256 grey levels. Each pixel is represented in the 

byte format.  

• 16-bit: images that can display 216= 65536 grey level.  

• 32-bit: images that can display 232= 4294967296 grey levels. Each pixel is 

represented in short format 

• RGB colour: colour images that can display 256 values in the Red, Green and 

Blue channel. These are 23x8= 24-bit images. 

After opening a new image, the image type can be set in the Image menu (Image→ Type). 

The images can be saved in different formats. The TIFF format is usually used in this 

work to save the modified pictures. 

 

Split Channels  

The option is included in the Image menu (Image→ Color→ Split Channels) and splits 

an RGB image into three greyscale images containing the blue, green and red components 

of the original image. Three images are obtained: (blue), (green) and (red). 

 

Duplicate 

The command Duplicate creates a new window with a copy of the original image. Also, 

if a rectangular part of the original image is selected with the Rectangle Selection Tool, 

the command creates a copy of the rectangular selection. The command is in the Image 

menu (Image → Duplicate). 

 

Smooth and Sharpen  

The Smooth and Sharpen commands are in the Process menu (Process→ Smooth, 

Process→ Sharpen). The first one blurs the active image or selection, replacing each pixel 

with the average of its 3 × 3 neighbourhood. The second option increases contrast and 

accentuates detail in the image or election, but may also increase the noise; it replaces 

each pixel with a weighted average of the 3 × 3 neighbourhood. 

 

Threshold  

The Threshold option is contained in the Image menu (Image→ Adjust→ Split Channels).  

The Threshold is a segmentation of the image that is needed to separate the object of 
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interest (particles in this case) from the background. The command only works with 

greyscale images and generates a binary image in which the black areas are the interest 

objects on a white background, or vice-versa.  

The threshold operation can be guided by the grey colour histogram displayed in the 

Threshold window; it represents a bimodal distribution with on its left the pixel belonging 

to the background and on the right those belonging to the object of interest. The minimum 

and maximum threshold values can be set by two sliders: the upper slider adjusts the 

minimum threshold value and the lower slider sets the maximum threshold value. There 

is also the chance to apply an Auto threshold that automatically sets the threshold levels 

based on an analysis of the histogram of the image or selection.  

 

Erode, Dilate and Close 

These commands are in the Process menu and in particular in the Binary submenu which 

contains commands to process black and white images (Process→ Binary→ Erode, 

Process→ Binary→ Dilate, Process→ Binary→ Close). They assume that the objects are 

black and the background is white.  

The command Erode removes pixels from the edges of the black objects in a binary 

image. Pixels can be instead added to the edge of objects by the command Dilate.  

With the Close command, a dilation operation, followed by erosion is performed, 

smoothing objects and removing isolated pixels. This can help to eliminate undesired 

surface irregularities of the objects.  

 

Watershed  

The Watershed segmentation (Process→ Binary→ Watershed) is a way of automatically 

separate touching objects or cutting apart particles that touch. It first calculates the 

Euclidian distance map (EDM) and find the ultimate eroded points (UEPs). To obtain the 

EDM each foreground pixel in the binary image is replaced with a grey value equal to 

that pixel’s distance from the nearest background pixel. The ultimate eroded points are 

maxima of the EDM and their value is equal to the radius of the largest circle that fits into 

the binary object, with the UEP as the centre. The Watershed command dilates each of 

the UEPs as far as possible, either until the edge of the object is reached or the edge 

touches a region of another growing UEP.  
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Adjustable Watershed  

The Adjustable Watershed is an additional ImageJ plugin that can be installed from online 

sources. The Watershed command described above has not parameters to adjust and 

especially in the case of touching objects the segmentation can be not correct. In the 

Adjustable Watershed, instead, there is the possibility to set the tolerance that in the 

standard Watershed is equal to 0.5. The tolerance determines the difference of radius 

between the smaller of the largest inscribed circles and a circle inscribed at the neck 

between the particles.  

 

Analyze Particles  

The Analyze menu contains commands related to the measurements on image data and 

plugins related to image analysis. In particular, Analyze Particles (Analyze→ Analyze 

Particles) is the command that counts and measures objects in a binary or thresholded 

image. A range of size (in pixel2) and a range of circularity can be set for the analysis of 

the objects.  

In output the results of the analysis are displayed in a tabular form: the parameters 

reported in the table are those that are set in Analyze→ Set Measurement. The interesting 

parameters are in this case the area, the centre of mass, the shape descriptors, the 

perimeter and the Feret’s diameter. So, area, x and y coordinates of the centre of mass, 

perimeter, circularity, Feret’s diameter, solidity and aspect ratio of the particles are 

reported in the results table. Moreover, in output also the Outlines or the Overlay Outlines 

can be shown. The Outlines image contains numbered outlines of the measured particles, 

displayed in a new image. The Overlay Outlines are instead outlines overlaid in the 

original image.  

 

Finally, it is possible to record a Macro with all the commands so that the same procedure 

can be repeated on each image automatically.
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http://imagejdocu.tudor.lu/doku.php?id=plugin:segmentation:adjustable_watershed:start 

(16.05.2017) 

https://www.freecadweb.org/?lang=it
http://imagej.net/Plugins
http://imagejdocu.tudor.lu/doku.php?id=plugin:segmentation:adjustable_watershed:start

